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Chapter 1

General Information

1.1 About this Book

This documentation serves as a reference of the CAM functions of Cenon. It is meant
as a reference guide as well as a working guide.

Depending on your computer system (Linux, Apple) or the applied Theme (skin),
there are differences in the look of the user interface. The panels depicted in this book
may differ in their look from the interface you are using, although the placement of
the controls remain identical.

The various computer systems (Apple, Linux) also show some differences in the
directory structure. This information is always given for all systems.

This book was created using LyX on Linux. The cover page was designed using
Cenon.

All trade marks like PostScript, Adobe Illustrator, HPGL, DXF, Gerber, Excellon,
Sieb&Meyer etc. belong to the respective owners.

9



10 CHAPTER 1. GENERAL INFORMATION

1.2 The history of CAM with Cenon

Manufacturing is how Cenon started at the end of
1992 and is one of the major strength of Cenon. In the year 2000, restructuring
of Cenon was started to bring Cenon to the new plattforms Apple and Linux. Cenon
was also turned into a modular system.

Since version 3.6 of Cenon, the CAM functions reside in their own module. This
gives Cenon a great flexibility and more users, especially in the area of vector design
and Desktop Publishing. As a result, also the CAM functionality greatly improved.

Cenon CAM is very well prepared for the coming innovations in the sector of Com-
puter Aided Manufacturing.
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1.3 What can you do with Cenon CAM ?

We thank our clients for their kind permission to use these pictures. You can find many more pictures
on the Cenon web-site.

Manufacturing is the native application of Cenon. That is how Cenon started. Since
1993 this important application of Cenon has been continuously developed and im-
proved. Today, Cenon is at home in almost all areas of manufacturing. The wealth of
installations world wide ranges from Engraving of embossing plates, Model Making,
and Sign-Making, to Industrial serial production.

Key Features

* Well structured and transparent work flow with short learning cycles

* transfer of data from almost any graphics- and CAD-application, as well as the
internet, through Cenons vast import capabilities.
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automatic tool radius compensation to inside or outside
Pick Out function for high precision engraving

Relief function on raster images and vector graphics to create 3-dimensional
relief images

Drills, threads, countersinks

Stepwise machining in variable step widths
Smoothing

Angular Approach

Webs to support parts during manufacturing
Selective Manufacturing

Precise interactive positioning of machine
Teach-In

Tool management

Output to HPGL-, ISO (G-Code/NC-Code), and DIN-66025 compatible de-
vices

Output Statistics with estimates
Camera-Gauging (Option)
Prototyping of Printed Circuit Boards PCB (Option)

Flexible Automation, allows serial production with customized parametriza-
tion (Option)
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Examples of application
» Sign Making
* Engraving (door signs, goblets, coining dies, ...)
* Wood Working, Furniture Making
* Reliefs (coins, embossing tools, furniture, etc.)
* Industrial engraving (type plates, labels, signs ...)

* Electronics (front panels, switch boards, prototypes of printed circuit boards,

)
* Model Making (models of buildings, industrial appliances ...)

¢ Precision Mechanics

 Cutting, for example cutting of foils for polishing optical glasses, sandblast
foils, leather

* Production of individual operation panels or dashboards

* you name it

1.4 Other products around Cenon CAM

This chapter introduces some products and services around Cenon CAM.

1.4.1 Additional Features

Cenon CAM can be extended by additional functionality. The following is a list of
add-on features:
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* Camera+Targeting
* Prototyping of Printed Circuit Boards (PCB)

¢ Flexible Automation

For more information visit our web site (http://www.Cenon.de) and the Cenon
CAM web site (http://www.Cenon. com).

1.4.2 Machining Systems
Selected Machining Systems for Cenon

To make it as easy as possible for you to find your Cenon machining system, we
prepared a number of selected machining systems for a variety of applications. You
can configure each system online to your needs and request an offer.

Other Machines

Cenon CAM can drive most CNC-machines supporting a command set based on
HPGL or G-Codes. Additionally some CNC-Controllers with special command sets
are supported by Cenon CAM. Though, not all CNC-controllers on the market show
equal performance. We can offer assitance to configure Cenon CAM to get the most
out of your choice of machine.

Retro Fits

On request, we also offer a bundle including Cenon CAM with a modern CNC con-
troller. This enables you to convert almost any 2 or 3 axis mechanics into a state-of-
the-art machining system.

For more information visit the Cenon CAM web site http://www.Cenon.com.


http://www.Cenon.de
http://www.Cenon.com
http://www.Cenon.com
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1.4.3 Tools and Tool Parameters
Tool Parameters

We offer an online calculation of tool parameters which gives a good idea of the tool
parameters for a given tool and material. You can find the tool on the Cenon CAM
web site:

http://www.Cenon.com

4 \F
/ o o
7 b
// @ee «# Online Calculation of Feed and Revolution for carbide tools - vhf-interservice
4 =] % ~ e
¥ SLE ) 88 (- oo )

. http: | /www.vhf.de/cgi-bin/ToolCalc?ing=gb .

carbide Tools

Calculation of Feed and Revolution

Please select the material from the pop up menu and enter your machining data. After pressing the Calculate
button you will receive standard values for revolution speed and feed for working on the chosen material.

Material: | Aluminium, pure
Tool: |_cytindric tool
Number of cutting edges: [z ]

Diameter: 3 mm

Revolution speed range: from 5000 U/min 10 60000 U/min

Max, feed: 20 mmys

N
C
(0 [ Calculate |

4 S olomms
> % The parameters provided are generally calculated for cast material, if you work with extruded material, the
1} provided feed need to be reduced.
Q’:(\ .‘( Know How: What you should know about tools
0\ > 2 We are happy about hints and experiences, helping us to improve this service. You can E-Mail your
,*_‘; ( suggestions to service@vhf.de
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Online Tool Shop

What would be manufacturing without tools? vhf provides carbide tools via their
internet shop since 1997. You’ll get everything here that makes chips, and shipping

is world wide.
Go to http://www.vhf.biz/tools to find tools and related stuff.

1.5 Installation

The installation process for Apple and Linux (GNUstep) differs. Please read the
section for your System.

Here we describe the installation of the executable packages only. If you want (or
need) to compile Cenon yourself, take a look at the file INSTALL inside the source

tree.


http://www.vhf.biz/tools
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1.5.1 Installation on Apple (Mac OS X)

1.

Insert the Cenon-CD and wait until the CD-Symbol appears in the Finder.
Then click on the CD-Symbol and goto into the directory *Apple > Packages >
CAM’. If you downloaded Cenon, you have to unarchive the downloaded file
instead (double click).

. You will find a package with the name Cenon.pkg. Double click the package

to start the installation.

. The installer appears, where you have to authorize yourself as administrator.

. Then you can start the installation process by confirming the various stages

(Introduction, Read Me etc.).

If you plan to install an alternate set of CNC configurations, you have to do
this in the step “Installation Type” by pressing the button ”Customize”. See
picture below.

. If you have a previous version of Cenon already installed, the install program

will notify you. Just continue the installation.

. After the package is installed, you can start Cenon. To do this, go to the direc-

tory ’/Applications’ and start Cenon with a double click.

If you have installed Cenon the first time, the license panel appears. Here you
can license the program, or you can run Cenon in demo mode.

. Your CNC controller may have a serial interface to be connected to the com-

puter. Since newer Apple computers doesn’t provide a serial interface, you
need an USB adaptor - usually this is a adaptor from Keyspan:

http://www.keyspan.com

Install your Keyspan adapter and the driver software as given in the adaptor
documentation. To be sure that everything works, you can use the ’Serial As-
sistant’ coming with your Keyspan adaptor.


http://www.keyspan.com
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If you have problems, you can check the device entry (#DEV) in the Cenon
device configuration (Kapitel 4.2). The device entry must be equal to the de-
vice created by the USB adaptor (/dev/tty.USA...). The devices in the Cenon
configuration provide a wildcard **’ to allow automatic device expansion.

Tip: If it happens that the serial device hangs (e.g. no device is connected),
than you can unplug the USB adaptor to regain access. You can use the
cu device instead of the tty device to avoid the hanging of the device and
Cenon in this case.

8. To come into the pleasure of importing PostScript or PDF files, you have to
install GhostScript. You can get a version of GhostScript from the same place
where you got Cenon, but any other version of GhostScript will do the job.
Double click on the GhostScript package to start the installation.

AAA « Install Cenon CAM 4.0.0

Custom Install

Package Mame Action Size
© Introduction ™ Cenon CAM Upgrade 59,6 MB
Read M ™ Devices for vhf CNC 550, 950, ... Upgrade 20 KB
g W Devices for vhf CNC 450 Upgrade 164 KB
) Destination Select ™ Devices for vhf CNC 750 Upgrade 193 KB
@ Installation Type !:! Devices far Step-Four Machines Skip 193 KB
3 [ Devices for ISEL Machines skip 12 KB
8 Installation [ Devices for Tool-Plotters (Aristo, G... Skip 111 KB
@ Sumnary [l Devices for Plotters (HP, ...) SKip 102 KB
] Devices for XpertCNC Controller Re.., Skip 16 KB
] Devices for G-Code (DIN) Configur... Skip 106 KB
Space Required: 53,9 MB Remaining: 199,39 GB
I —
(" Standard Install ) ( CoBack ) [ Install )

1.5.2 Installation on Linux

1. log in as user root



1.5. INSTALLATION 19

2. Insert the Cenon-CD and mount the CD. Then change to the directory ’Linux >
1386 > CAM’ or 'Linux > ppc>CAM’, depending of your architecture. If you
downloaded Cenon, you can skip this step.

3. You will find a RPM package. Install it with the installation tool of your Linux
distribution, or enter the following command in a terminal shell:

rpm -Uhv Cenon*.rpm

4. To start Cenon go to the folder /usr/GNUstep/Local/Applications and start
Cenon with a double click. If you don’t have GWorkspace running you can
start Cenon by typing ’openapp Cenon’ from a shell.

If this is your first installation, Cenon will ask you for a license key.

1.5.3 Installation on OpenStep (Deprecated)

1. Log in as user root

2. Insert the Cenon-CD and wait until the CD-Symbol appears in the File Viewer.
Then click on the CD-Symbol and go into the directory *Apple > Packages >
CAM’. If you downloaded Cenon, you have to unarchive the downloaded file
instead (usually a double click should work).

3. You will find three packages, which you have to double click one after the
other. The names are:

(a) Cenon.pkg
(b) CenonLibrary.pkg
4. For each package a window will appear, where you have to click on Install.

5. Then another window appears. Just click on Install or press Enter. The files
are now extracted from the file and copied to the hard disk. This takes a few
moments.
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If you have an old version of Cenon already installed the install programm will
notify you. Just continue the installation.

6. Wait until the first package has been finished before installing the next one.

7. After all packages are installed start Cenon as user root. To do this, go to the
directory ’/LocalApps’ and start Cenon.app with a double click.

If you have installed the CAM version of Cenon for the first time, the license
panel appears. Here you can license the program (See the next section) or
decide to run it in demo mode.

1.6 Licensing

In the Info menu of Cenon you can call the licensing panel. The first time you start
Cenon CAM it will appear anyway.

& IEETIN File Edit Format

By nl -

About Cenon ...

Preferences...

| Project Settings ... C#S
Services >
Hide Cenon 38 H
Hide Others
Show All
Quit Cenon ®Q '

In the following panel you can find the Host-1d or Serial-Number of your computer.
Please send this Id to us (info@Cenon. com) to get your password.


info@Cenon.com
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20e Cenon Registration

Registration Form

: Licenses Module Owner Expires
020010 CAM Cenon

Add License: Host: CO2JV3FSDNMP
Passwaord: {02001{J-m00m00m00{ ]

MName: Demonstration
Organization: Cenon GmbH
Street: Schwabstr. 45

City: Rottenburg a.M.

Country: Germany

| Demo | |_Eanoel | [ EnmrJ.Jmnsn-J

Special Features:

CAM PCE Prototyping
CAM Camera Gauging
CAamM Tool Parameter Calculation

CAM Flexible Automation

Please enter (or copy) the password into the password field. Then enter your name
and address.
Finish the licensing process with a click on ”Enter License”.

The upper part of the Panel shows the active licenses. The lower part of the panel
shows the features and their status of activation (Blue = activated).

1.7 Initial Operation

You will find Cenon in the application folder. Double click on the Cenon.app to start
Cenon. The CAM module will be loaded automatically.

In the library folder of Cenon you will find some examples: The folder "CAM/Jobs’
provides some examples of Jobs.
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The library of Cenon resides in slightly different places, depending on your system:

Apple: /Library/Application Support/Cenon
GNUstep: /usr/GNUstep/Local/Library/Cenon

OpenStep: /LocalLibrary/Cenon

1.8 Support

User guide We try to keep the user guide practical and full of information. The user
guide should answer most of your question.

WwWWw You can find information about new versions and an up-to-date FAQ
(frequently asked questions) on our Cenon-CAM Website:
http://www.cenon.biz.

Mailing list In the mailing list of Cenon, you can ask questions and exchange your-
self with other users of Cenon. To subscribe to the mailing list you can
go to the Support page of the Cenon internet site.

eMail The best support is certainly possible via eMail, as you can attach ex-
ample files easily here.

Bugs If you find a bug, we are thankful to receive your bug-report. We will
try to fix serious bugs for the next release.


http://www.cenon.biz

Chapter 2

CAM with Cenon

2.1 Methodology

In the following we will give you a short overview of the fundamental procedures for
the output of a graphic. In the following sections you can find detailed information
about all the (possible) operations.

* Import of a graphic

 Creation of layers for every necessary operation Distribution of the graphic to
the right layers.

* Setting of the tools that you want to use.
 Allocating of the tools to the layers. Setting of the dip depth.

* Positioning of the machine. Starting of the output.

23
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2.2 Output of a graphic

In the following we show you all the single operations to work with a graphic file on
your milling and engraving machine. Our example is an imported graphic-file that is
not edited.

Editing: The editing-functions of Cenon are described in the Cenon main book
beschrieben.

2.2.1 Import of the graphic file

First you have to load the file. It can have Postscript (EPS or Al), HPGL, DXF,
Gerber or DIN format. Cenon recognizes the format automatically. You only have
to choose the command "open" in the file-menu and select the right file from the
graphic-file-window.

Menus: The description of the several menus you can find in section 3.3. and in the
Cenon main book

For our example we want to load an Adobe-illustrator file. This file belongs to your
delivery extent of your Cenon version. It is installed automatically in the library
path. Go to path: Library/../Cenon/Examples/ai and load the file "high tension.ai"
that looks as follows:
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2.2.2 Creation of layers - partition in several production units

Several production steps are needed to work with such a graphic file on your machine.
In this case there are at least two - the engraving of the flash and bordering, and
cutting out the sign from the base material. These two operations will be handled in
Cenon by two layers.

First you can choose another color for the grey graphic-file. Open the inspector. It
offers you information about the selected graphic-file and you can alter it. You can
find the inspector in the menu tools (entry inspector). When no element is selected
the inspector shows the position of the crosshair. Click on the outer contour of the
graphic. In the inspector a field appears that shows the color of the selected element
(here light grey).
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VA Path

SOE |+ 2
Basic . ]
Color

Graduate Color

Graduate Angle

0 J L.-_:I A
Radial
Center

Stepwidth 7 |

Inspectors: You can find further details about the inspector in the Cenon main book.

Click on the outer frame of this field. You get the Color-Panel with different options
(you get the same window when you choose the entry colors in the menu tools). Here
you can choose a shining yellow that suits for a warning signal.

Although black would be o. k. for the flash and the frame it’s better to choose a
brighter color because Cenon shows the ways of the tools also in black. To be able
to see the difference it’s better to choose grey.

After you have chosen the colors it’s time for the CAM-Panel to separate the different
operations. Open the CAM-Panel in the menu Tools (if it’s not open already). The
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CAM-Panel consists of "index cards". When you click on the name of one index card
it is taken to the foreground and you can enter the settings.

o e CAM Panel

{ Laver I Magazine  Control = Positions ]

| vhf RubOut-Cutter 1.0 mm 4] & 02 |~z DisplayGraphic ¥
&7 pF @1 Cutting 2-Edge Cutter 2.0 mm Dispiay Qutput |}
& /7 0.2 Engraving vhf RubOut-Cutter 1.0 mm

Engraving

[ Move to Layer |

f Y f %
[ New Remove |

£

Show Details .. |

To separate the operations to the different layers you have to choose the index card
Layer. With this panel you manage the layers, say the different operations of your
graphic file. At first there is only one layer in the Layer Panel which is called "Non-
ame”. On the left of each line of layers are 4 different icons with which you can
influence the design and the path calculation. The numerical value next to the icons
indicates the dip depth or immersion depth of the tool, on the right you can see the
name of the layer and on the right to the layer you can see the selected tool (in this
case you cannot see a tool yet because none has been selected yet).

& 7. M 0.2 Engraving vhf RubOut-Cutter 1.0 mm

The name of the layer (here: Layer 1) should describe the respective operation. In
this case you can enter e.g. "milling" for the layer that contains the outer contour
(don’t forget to confirm the input with "enter"). You can edit the name in the small
field on the right of the window. Then you have to create a second layer that contains
the engraving. Click on the button new and you get a further layer. You have to give
this layer a new name, too, e. g. "engraving".
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Now you can select the elements you want to engrave in the graphic window, the
frame and the flash (by pressing the Shift-key during this selection you can choose
more than one element (at the same time). Then you can select the second entry (en-
graving) in the layer-panel and click on Move to Layer. This will move the selected
elements to the current layer. Now you have separated the two operations milling
and engraving successfully.

You can let Cenon carry out the operation for you (distribute the different elements
with different colors on different layers. Therefore you have to switch on the button
import colors on the layers in the window preliminary settings before you import the
file (you get to the entry preliminary settings from the menu information.)- So you
can spare a lot of effort later.

Now you can set some further parameters; therefore you can use the icons.

& The eye on the left shows if the layers are displayed/shown. When the eye is
closed the layer is not shown. Especially for control purposes we recommend to fade
out some of the layers to be able to check whether the single elements are on the right
layer.

e With the small pencil you can decide whether a layer is editable or not. When
you break the pencil you cannot change/transform/alter the layer any longer. So it is
also protected from unintentional actions.

Lf:’ With the color-pot you can decide whether the output of the layer should be
filled or not. In our case the engraving layer has to be filled (poured-out pot) and the
milling layer (outer contour) is not filled.

[ You can set the radius-correction with the last of the four icons. For the milling
layer you have to carry out an outward correction and for the engraving layer an
inward correction. It’s important that you choose the same diameter for the tool as
for the operation later because the radius correction and the calculation of the filling
alogarithm goes by the diameter of the chosen tool.

Some of the setting possibilities (and other special settings) that you can carry out
with the icons you can also find in the window layer-details (you get there with the
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details button). When you click on layer in the layer-details-panel you get back to
the layer-panel. But first you should set or check the needed tools.

Details: You can find further details about the Layer-Panel in section 3.4.1.

2.2.3 Setting of the tools

8.0 6 CAM Panel

{ Layer Control | Positions |

e L R

| Spindie <= 60000 rpm  : | | Aemove | Name: Spindle <= 60000 rpm

Single-Tooth Cutter 1.0 mm | Tool Parameter ...
single—Tooth Cutter 2.0 mm
Single-Tooth Cutter 3.0 mm
Single-Tooth Cutter 4.0 mm
Single-Tooth Cutter 5.0 mm
Single-Tooth Cutter 6.0 mm
Double-Tooth Cutter 1.0 mm Tool Info ...
Double-Tooth Cutter 2.0 mm

Double-Tooth Cutter 3.0 mm | New.. | | Remove

(o B v - T T o IR W [ R W N R )

This panel shows the content of the current tool-magazine. Here you can delete
existing tools and add new tools. With the pop-up-menu you can choose a different
tool-magazine and from there you can select a tool for the next operation. The tools
go by the ability to carry out a tool-change automatically (see plot-magazine).

When you click on parameter you can see the characteristics of the selected tool and
you can adapt them if you want. In any case you have to check if our set parame-
ters correspond to the actual values of your tools. If not change it according to the
instructions.

When you use different tools you should also mind that all the tools must be chucked
in the same height. Otherwise you have to set the z-position newly after every
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tool-change because you define the scratch-height with the z-contact value in the
disposition-control-panel. Use only tools with stopping ring that are assembled in
the same height if possible. If this is not the case with every tool you have to do the
following:

Click on the button parameter in the Magazine-Panel. The following panel will show
up:

8.0 6 CAM Panel

{ Layer Control | Positions |

Marme: Single-Tooth Cutter 1.0 mm |_Gutter -

Diameter (mmj: |1
| Caleulate Tool Parameter .. fun)

|
| Tip Angle (deg): |1

Cutting Edges | 1

ar

Max. Diameter (mm): | 1
Lowering Speed (mm/s): |3
Cutting Speed (mmy/s): 10

| Adjust Z-Offset (mm): 0

| Select/ Deselect | Revolution (1/min): | 40000

L P b b b b b
wvdwvwveww

Here you can find the entry z-offset (among other entries). With this entry you can
enter the difference of the height to the biggest tool (the value z-contact has to be
fixed with this tool). If the longest tool is 38mm from the stopping-ring to the top
and the actual tool is only 30 mm you have to enter 8 to the z-offset. You can use the
adjustment button to determine the scratch depth by trying out.

Details:  You can find further details to the tool-panel in section 3.4.4.

Tools: Interesting information about the tools, the selection, the calculation of
the rotary frequency, forward feed you can find in section 5.1.
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2.2.4 Assignment of the tools to the layers

After the adjustment of the tool parameter you have to assign a tool to every layer
and adjust its dip depth into the material. Therefore click on the Layer-Panel again.

On the right next to the red icon for the radius-correction is a numerical value (presently:0).
This value indicates the dip depth directly from the surface into the workpiece. For

the engraving some tenth of a mm is enough to get through the topmost layer of the
material. You can adjust the dip depth either with the help of the two arrow buttons

or you can enter the numerical values directly in the field between the two arrows.

For the layer that is milled you have to enter the thickness of the material so that it is
completely cut during the milling operation.

Single Tooth Cutter 1.0 mm
Single Tooth Cutter 2.0 mm
Single Tooth Cutter 3.0 mm
vhf Rub - Out 0.5 mm

vhf Rub - Out 1 mm

vhf |so Cutter 0.2

Drill 0.8mm

Drill 3 mm

Drill 5 mm

Zweischneider 4.0 mm

i PP P PR P P i,

R e B o T - RS N, R S WY R

-

With the pop-up-menu next to it you can select the tool with which the next operation
should be carried out on your engraving machine. Mind that you enter the right tool
diameter because it is needed for all the calculations. All the tools that are in the
actual magazine are shown.
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8N a6 CAM Panel

| Layer Magazine

Start Position

X: 0 4>
Y: 0 4> [ Home | |

| Suction
[ ezl A
Move Height: 1 L g
| Get || Save | Set | () Al
[ ) Selection
Tool:  No tool selected
Offset 0.0 [ Start

When you finally click on output in the Layer-Panel you can see the drive-ways that
were calculated by Cenon. They lay black over the original graphic. If it’s hard to
see the drive-ways it might be better to enlarge the display. Therefore you can find
a pop-up-menu on the lower border of your graphic window with which you can
choose the zoom-factor. The best way might be to click on the magnifying glass.
Then you can drag up an area of the graphic window that is enlarged to the whole
size of the graphic window.
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X: 646535 Y: 48.4035 W:-251 H;_:-1g.;a__. (@) - ][ 400%

Graphic window: Further details about the graphic window you can find in the
Cenon main book.

Your Layer-Panel should look almost like this when everything is correct:
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o e CAM Panel

{ Layer I Magazine  Control = Positions ]

| vhf RubOut-Cutter 1.0 mm 4] & 02 |~z DisplayGraphic ¥

&/ EE1 Cutting 2-Edge Cutter 2.0 mm Dispiay Qutput |}
& /U W 0.2 Engraving vhf RubQut-Cutter 1.0 mm

Engraving

[ Move to Layer |
[ Show Detalls ... |

Mew Remove |

2.2.5 Positioning of the machine

Now the preparation is finished and we can now start to go into production of our
graphic: take an appropriate multilayer plastic board (we recommend to take one
with a yellow top layer and a black basic layer). Now you can chuck the board onto
the engraving machine.

Now we come to the third part of the panel namely the machine Control. Click on
the appropriate index card and your window looks like that:
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8N a6 CAM Panel
| Layer Magazine Positions |-
Start Position
—_— - — M
X 0 \J } | Adjustment | [ Spindie
Y. 0 ‘J }’ |  Home | [ | Suction
]z 1 A
Move Height: 1 il
| Get || Save || Set | (=) Al
() Selection
Tool: Mo tool selected
Offset 0.0 [ ~Start ]

In the machine control you set the starting point where the machine is supposed to
start the operation on your workpiece. You can move the machine directly when you
click on the appropriate arrow buttons. If you want to enter the positions manually
don’t forget to press the Enter-button to drive towards the position. But Attention:
as soon as you press Enter or click on Set Position the machine moves to the given
position. If you give a wrong position (especially for z) this could lead to damage of
the spindle or the workpiece.

Start Position
X0 | (J }
v.o | (J }
Uz1 |law
Move Height: 1 & 7
| Get || save || Set |

That means it’s better to set the starting position with the arrow buttons for X, Y, and
Z. Move X, and Y to the lower left of your working piece, then lower Z down to the
surface, so the surface is almost scratched but isn’t. When you click on the arrows



36 CHAPTER 2. CAM WITH CENON

and press the Ctrl-key at the same time the machine is positioned in 1 mm steps.

The move height (or flight level) should be set to a secure value. This is the height
the tool will move above the surface of the working piece.

Use the memory for the positioning! Especially when you have a lot of workpieces
of the same size we recommend to justify the workpieces at the side stop and take
the saved starting position when you work with a workpiece of the same size.

To save a position move to the starting position in the machine Control-Panel. Then
choose the index card Positions. Now you are in the position-memory management.

Click on the pop-up-menu and choose the last entry New Position. Cenon takes over
the current position from the Control-Panel and calls it: UNTITLED. You can edit
this field and give it a proper name. Later you can recall the saved position, watch it
and finally move the machine directly there by clicking on Move to Position.

8.0 6 CAM Panel

{ Layer @ Magazine | Control

| Parking Position 4| | Remove | Name: Parking Position
X 249 d } add Marker Positions [ |
R Return to parking position | |
v: o 4> -
z: 10 AW
Maove Height: 1 o

| Move To Position |

As we already mentioned please mind that the Z-position is not too low when you
move to saved positions (e.g. when you use another pad). After you have clicked on
"move to the position" you get back to the Control-Panel automatically.

Details:  Further details about the Control-Panel and the position memory you
can find in section 3.4.5.
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2.2.6 Starting the output

Finally you can work with/on the workpiece. With the start-button the output starts/begins.
Before it’ll begins it’ll ask you to chuck the appropriate tool. Therefore the z-axis
moves to the zero position.

Depending on the system you use Cenon will start the spindle automatically after
you have chucked the tool and left the dialogue box. If your spindle is not equipped
with an automatic start you must switch on the spindle before you press OK in the
dialogue box!

= Alert
f‘ Insert tool #2:
== Einschneider 2.0 mm
oy

( cancel )} oK)

The machine starts to work on the workpiece. The machine starts to work according
to the sequence of the layers you have set in the layer-panel. that means in this case
the machine starts with the outer contour.

If you want to change the sequence you can do this as follows: the machine only
works on layers with open eyes. When you want to start the output with the layer
“outline”, shut the eye of the milling-layer and start the output. In a second operation
you can open the eye again and shut the eye of the engraving-layer.

A second possibility to output certain elements only, is to select the desired elements
in the graphic window. In the Layer-Panel, select the radio button ”Selection”. If you
press start only the selected element will be given out.

f=) Al

() Selection

When the machine is ready after an operation the z-axis moves back to zero-position
and asks you to change the tool until all the layers are ready.
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2.3 Pick Out (Carving)

The function Pick-Out (Carving) has been developed for the manufacturing of stamps.
Therefore you have to keep a few things in mind.

2.3.1 Preparation of the graphic

The pick-out will clear the black fields of the graphic. That means you have to create
a negative picture of your graphic. Your graphic appears then in white color on a
black background. The black background is cleared while the graphic is filled. The
outline of the stamp must lay within the negative graphic so that only the original
graphic remains raised.

You can also calculate the drive-ways for raster images (e.g. TIFFs) during the
pick-out. To get a good result you have to scan the graphic bigger than how it should
appear later. In the Cenon program you can reduce the size to the original size again.
You should scan the graphic at least 4 times bigger than the original size so that
Cenon is able to work with it. After you have dragged your graphic into the graphic
window you can start scaling the graphic in the transformation panel (menu work,
entry transform).

The bigger you scan your graphic the more exact is your result but also the longer is
the calculation-time. You need a negative picture of your graphic here, too.
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2.3.2 Selection of the tools

The Pick Out corresponds mainly to the inward tool-radius-correction. Additionally
the tool is raised in the edges and in parts that are too small to create an exact picture
of the graphic on the material best as possible.

The right choice of the tool plays a very important role because the Pick Out can only
be carried out with conical tools. Four values are decisive for the choice of the tools:

¢ maximum diameter
e diameter
* acute angle

» wanted dip depth

d3

h d2 Maximaler Durchmesser
dl Durchmesser

a  Spitzenwinkel

a1 h  Eintauchtiefe

d3 Berechneter Durchmesser

a

dz2

Cenon calculates the effective diameter (d3) of the tool from the dip depth (h). The
drive-way is calculated with the effective diameter (d3). When we come close to an
edge the way to the edge is searched and the diameter (d3) is reduced as necessary
by lifting the tool. The maximum accuracy in edges is determined by the diameter
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(d1). The same goes for passages that are too small for the maximum diameter (d2);
the diameter is reduced until it is small enough to go through this passage.

The tool is supposed to get through every passage with the effective diameter (d3)
(calculated with the dip depth) so that the tool has only to be lifted in the edges. Too
small parts on the graphic should be avoided if possible.
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2.3.3 Example

The example of a stamp will show a practical example. The stamp has an original
width of 34 mm and a text height of approximately 4 mm.

X 274385 Y. 27642 Witth:224455 Height 16757 |[mm %]

As we want to make a stamp, the motive is mirrored. The orange areas in the example
will be removed, the white text will remain.
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Layers and Tools

8086 CAM Panel
m Magazine | Contral I Positions ]
{ Stichel 0.2 mm, 36 Grad %) A[1s |~y Display Graphic @
® /K 418 pPckout Stichel 0.2 mm, 36 Grad Display Output £
= 1.8 Filling Stichel 1.0 mm, 36 Grad Pickout |

= ~F B0 Info

Remove

P

The PickOut offers two layers. The first layer is responsible for the actual pick out
process. The second layer is filled and makes the rubout.

In the example a conical tool is used with 0.2 mm tip diameter and a tip angle of 36
degree. The first tool must be conical!

For the filling, the example uses a conical tool too. It has a tip diameter of 1.0 mm
and 36 degree tip angle. The tool for filling may be cylindrical.
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The result is a complex fill pattern. The images show the engraving tracks of an
enlarged part of the screen. The first Image shows the Standard-Filling, while the
second image shows the Contour-Filling.

The three processing steps are clearly visible:

1. rough filling using the filling tool
2. fine filling using the pick-out tool

3. pick out

Tip:  The Contour-Fill can be activated in the Project-Settings (see section ??).

Tip:  Cenon offers Vector- and Raster-Algorithms. In case the Pick-Out shows
a critical spot with problems, you can change to the Raster-Algorithm (see
section ??).
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2.4 Creation of Reliefs

Using the Accessory Inspector you can enable the Relief function for graphic ob-
jects (Image, Path, Rectangle, Arc, PolyLine). The Relief function allows turning
Grayscale shading into 3-D output.

Examples are Reliefs in furniture making. Also processing steps like Chamfering or
Slanting can be achieved.

If you set the relief switch, the output is calculated as a relief with Z representing the
grayscale.

0 O O Path
510l =)
Relief b4

Apply Relief M

Depth Algorithm

4 -

Linear

Cutting Direction

Horicontal ==

The colors of the image now represent a Z-level. Black color is rubbed out using the
dip depth assigned to the layer (see section 3.4.1). For white color the material is not
touched - the cutter moves at surface level.
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The gray shades in between black and white are handled in three possible ways,
depending on the settings in the Inspector:

Depth Algorithm

Linear = ]

Here you can select the kind of graduated processing of the image:

Linear The gray levels are processed in a linear way

Circular The gray levels are processed in a way that a linear graduation
results in a circular cutting of the material.

Logarithmic The gray levels are processed logarithmic.

Cutting Direction

' Horicontal [ i

Here you can set the cutting direction (Horicontal, Vertical, or both):

« If the Filling is activated for the Layer (see section 3.4.1), the graphics will be
processed applying the selected Depth-Algorithm in the given direction.

* If the Filling is disabled, then only the contour of the graphics will be cut,
applying the Depth-Algorithm to the contour.

Flatness %

o0 | —6 )

The Flatness can be set in percent between 10 and 100. At 100% the length of the
output-lines are equal to the tool diameter. At 10% the lines are only 10% of the tool
diameter, which takes more time but gives much smoother results on curved surfaces.

If the shape is convex or concave (curved) and the tool diameter is large, then the flat-
ness must be less than 100% to achieve a smooth surface. But also a too large cutter
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may have negative effects on the results, when the tool radius doesn’t fit the gradient-
changes. Good results are achieved by carefully chosing the right tool diameter for a
given curvedness.

The Fill-Overlap (Layer-Details) should be set to O for a Relief.

Tip: To cut out a relief from the material, you should create a separate layer with the
contour of the cut.

2.4.1 Relief with Vectorgraphics (Path, Rectangle, etc.)

The contour of the graphic objects is always applied.
The filling is processed only, when the Graphic Object is filled and the Layer in the
Layer-Panel is filled (bucket pouring, see section 3.4.1).
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2.4.2 Relief with Raster-Images

An Image (Raster-Image), that shall be processed as a Relief, should be grayscale
and provided to Cenon in High Resolution (ex: 300dpi). Following the import of the
image to Cenon, the image has to be scaled down to the desired size.

The diameter of the tool used for the Relief, should span as much pixel of the image
as possible. As a rule of thumb, the image needs to be scaled down at least by factor
3. You can use the Transform-Panel to do so. The finer the tool, the more the image
should be scaled down in Cenon.

Note: Scaling down the image in Cenon will keep the full resolution of the image.
Join of an Image and a Path

An Image can be clipped by a Path, by joining the Image with a Path (see Cenon
Manual). When processing the clipped image as a Relief, the joined Path will be
used as the contour, analog to processing the Relief of a vector graphics.

When joining an Image with a Path element (Path, Rectangle, Arc, PolyLine), the
image should be slightly bigger (overlap) than the Path.
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2.5 Camera-Gauging

This feature allows the recognition of position, orientation, and distortion of a work-
ing piece by using a camera mounted on the machine.

The parts to be processed are placed approximately on the machine table. Now the
camera-image can be analyzed to obtain the exact position, rotation, and deforma-
tion, relative to the constructed (original) graphics. During output, the graphics will
be transformed, so that it fits the working piece.

Possible applications are, cutting of Large Scale Prints in the Sign Making industry,
or the processing of Screen-Printed front panels or keyboards. Whenever multiple
working-steps need to be combined (ex: Printing -> Cutting, Laminating -> Milling,
Drilling, etc.), the camera function can be applied.
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8086 Camera

Pattern Definition ¥

C Semings )
I Define Pattern - Define First Marker )
(__Define Pattern )

P

The bridging elements between Graphics and Working-Piece are Reference-Markers
printed on the graphics (or corners of the material). In Cenon, the Reference Markers
are placed as Markings on a dedicated layer.

The application is very easy using three buttons only:

1. Define Pattern (of markers)
2. Move first marker into camera-view

3. Start Output

To activate the camera function in Cenon, you have to enter the appropriate Key into
the Licensing-Panel of Cenon (see section 1.6). You also need a camera connected.
Please contact us for details.
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2.5.1 Preparing the Project - building the bridge

The primary step to prepare a Camera-Project is to add a layer with the Reference
Markers. This layer will be the bridge connecting the target graphics and the working
piece on the machine. So first, create a new layer (see section 3.4.1).

EF,SBEHEL1 Job Einschneider 1.0 mm
& o= 0  Camera Marker

Then go to the Layer-Details (Kapitel 3.4.2) of the CAM-Panel, and change the Type
of the layer to "Camera Layer”.

— { Layer | Magazine

' Camera Layer |2 ]
Camera Marker -e'

On the Camera Layer, you have to place Markers at the target positions (fitting the
original Graphics on the other layer). These Reference Markers have to be present
in some way (Crosses, Circles, ...) on the working pieces, also. Usually they are just
printed or screen-printed with the first step of manufacturing. At least 3 markers are
needed.

®6e6 “ CameraGauging.cenon

X: 67.2583 Y: 1042998 Width: -4.2333 Height: 3.5278

+ +
+ +
+
+ T
+ i
v
[ F—————————————- . B EIGF:

In Cenon, you will either place a Mark (see Cenon User’s Guide, Markings) for each
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of the Reference Markers, or another element like a cross (two crossed lines), a circle,
a path, etc. The center of each marking object will be used as Target-Position. These
marking objects can easily be extracted from an imported graphics, for example using
the "Move to Layer” functionality.

You don’t have to place the markings as wild as in our example, which is demonstrat-
ing the flexibility. Generally the best advice is to keep things simple and arranged.

For Batch Production it is suffitient to set the markings for the first piece of the batch.
All other pieces can be processed automatically.

2.5.2 Import of Cut-Files
Cenon is able to import cut data from RIP processors in various formats, for example
SVG or i-Cut.

The i-Cut format can contain all needed layers. If it does, Cenon will create all
needed layers.

0 CutContour
& B H0 PDFTrimBox
& 7 0  Kamera Marker

2.5.3 Action
The entire Output, is based on three buttons only: “Define Pattern”, "Define First
Point”, ”’Start”.

After opening a Camera-Project or creating the Camera-Layer, the Camera-Panel
will open and displays the view of the connected camera.



52 CHAPTER 2. CAM WITH CENON

1. Define Pattern

Now, you have to move one (usually the first) marker of the working piece into the
camera view. To do this, use the Arrow-Buttons for X and Y in the Control-Panel
(see section 3.4.5).

806 Camera

Define Pattern Define First Marker

A

To avoid unnecessary distortion by the camera optics, the Reference Marker should
be moved into the circle of the crosshairs.

After the Reference-Marker is recognized and its position and size is marked correcly
and stable by a green circle, you can press the button ”Define Pattern”. The pattern
of the Reference-Markers is now defined and will later be used to recognize the other
Reference-Markers.

The small image in the lower left corner of the camera view displays the pattern rec-
ognized, and is a help to decide for the correct recognition of the pattern. The small
image will disappear after this step. Before pressing the “Define Pattern” button,
make sure that the small image appears massive and stable.

This step of the pattern definition may be omitted, once the pattern is defined. The
defined pattern will be saved with the document and stays defined for later use. It
may still be necessary to redefine the pattern, if the light has changed.
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2. Move first marker into view (Reference-Point) / Start Camera-Drive

If not already done in step one, move the first marker into the circle of the camera
view. The first marker is emphasized by a blue circle in the Graphics Window - it is
the one closest to the Document-Crosshairs.

Q. A B Camera

8ee ﬁ CameraGauging.cenon
X: 106.0639 Y: 93.0108 Width: 116.0639 Height: 103.0111
-

= +
# B r
I +

Partern Definition v @ o+ .
() () + K
(st paters )| J;
# A|lw g

When the first marker is completely inside the view and marked by the green crosshairs,
you can press ~Define First Marker”

Q. A B Camera
66 % CameraGauging.cencn
X: 16,1055 Y: 616137 Width: 26,1056 Height: 71.6138
F..
= =
+ i r
l +
Pattern Definition ¥
@ © + g
| ( Define First Marker ) |E
1L a— i BN P

By pressing the button, the first marker is defined and is automatically moved into the
center of the camera view. Immediately after centering the first marker, the Camera-
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Drive starts to collect all the other markers.

While moving the marker being approached next, is emphasized by a blue circle. If
recognized the circle changes to green, and in case it is not found, it will be marked
red.

Blue Circle The Reference-Marker is being approached
Green Circle  The Reference-Marker has been successfully recognized

Red Cirle The Reference-Marker has not been found and will be omitted

a66 %t CameraGauging.cenon
X: 760778 Y: 104.6526 Width: B6.0778 Height: 114 6528

o)
e

All reference markers have been recognized successfully. The output paths (enable
the switch in the Layer-Panel) are transformed to fit the working piece placed on the
machine. In the next step you will start the output.
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3. Start Output

806 CAM Panel

! Layer Magazine | Control | Positions

Start Position
= e O
x: 102024 D | spindle
e =
v: 131420 { D i I Leveling
" Switch
Oz 1 Aw -] 1] LW
. | Chuck
Move Height: 1 & = F Gibeiing
. Get | ( SetPosion ) @ Al
() Selection
Tool: Mo tool selected
Offset 0.0 ¢ Start )

F

In the Control-Panel, you can start the output as usual by pressing the Start button.
The start position has been set automatically to the First Marker (when centering the
first marker). The crosshairs in the document window have no meaning for output
with the camera.

A click with the mouse on ”Set Position”, will bring the camera (machine) back to
the position of the Reference-Marker.

+ +
+ +r

v

+

+

Image: our simple example was printed on a Laser-Printer, then the contour has
been drawn by a pen-plotter
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2.5.4 Other Applications
Corner-Recognition

This mode can be used for fast cutting of rectangular parts, recognizing corner marks
(crop marks) to obtain the shape.

To apply the Corner recognition, follow these steps:

1. In your Cenon-Project, place a Marker for each Corner Point on the Camera-
Layer. For a batch of Objects, you only have to place the markers for the first
object of your batch. The first object is the one at the lower/left position.

2. For batch production generate the other markings using the batch-function (see
the Cenon User”’s Guide “Batch Production’) of Cenon. Use the button ’Set”
to define your batch.

3. Position the machine to the lower/left Corner of your Material and define the
pattern of this corner.

The recognized markers will be turned into a Path in Cenon, located on a dedicated
output-layer. Cenon will create this layer if needed.

e If the corner markings on the material are true ”Corners” that are not tolerant
to rotation, then exactly 4 corners have to exist. Here, the lower/left mark must
be used to define the pattern. Cenon starts with the Camera-Recognition on the
lower/left corner and proceeds counterclockwise. To allow the recognition of
the corners, the defined pattern will be rotated by 90° after each step.

L

The marking of a corner in Cenon has to be at the exact position at the corner
marking. The red cross in the picture shows the correct position relative to the
printed Crop-Mark on the material for two different kinds of Crop-Marks.
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 Using Circles or other shapes that are tolerant to rotation, any number of mark-
ings can be used to definde the shape.

Prototype Placement

The Prototype Placement allows to output graphics or apply manufacturing steps at
positions recognized by the Camera. For example to place drills or threads at the
position of markers printed on a working piece.

To be able to use this function, you have to define a graphic prototype (Drill, Thread,
...), that will be applied to the positions recognized by the Camera. To define the
Prototype, you have to create a Template-Layer (see Section 3.4.2), and place on it
the Prototype element. During the Camera-Recognition, the graphic element on the
Template-Layer, will be duplicated on a dedicated output-Layer for each recognized
marking. When the camera is done, the Output-Layer is ready for output without
further preparation.

All settings of the camera, can be modified in the Project-Settings (section 3.2.2).

2.5.5 Problems and Solutions

®O06 & CameraGauging.cenon

X: 654944 Y: §7.9488 Width: -5.8872 Height: -2.8222
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If some reference markers were not found, light could be a reason. If the light is not
suffient, then a ring-illumination mounted at the camera may help.

Also, too much light might be the cause of problems. In this case less light helps,
especially with reflecting material.

A wrong selection of a pattern may also be the cause of a failed recognition. For
example, if the Pattern-Preview shows holes, that actually are not in the pattern.
When defining the pattern, make sure the pattern is recognized stable.

If the objective of the camera is strongly rotated (camera image not angular to the
axis of the machine), then the direction is not translated correcly and the markers are
likely missed.

Also, if the second marker has been missed, then probably no other markers can be
found as well.

The reaction of the camera gauging to errors are generally good-natured. Not rec-
ognized markers can be omitted and not used in the transformation, or they can be
defined manually by the user.

Precision

The precision of the camera-measurement is dependant on the resolution of the cam-
era image, and limited to about 2 pixel of the camera image.

If the section of the working piece in the camera-view is too small, then only a small
rotation of the working piece is allowed and recognizable. Therefore, we have to
accept a compromise between high precision and a large area of recognition.

Angularity

Move the camera over a marker and take a look at the camera image. If the position of
the marker in the camera-image is gradually moving while zooming the camera, then
your camera / Z-axis is not mounted angular to the machine table and the gauging
results may suffer.
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If the position of the marker on the camera image is jumping instead of gradually
changing then the mechanic of the zoom is not good enough for this test.

Focus

The focus is only good within a tolerance of about lcm of distance change. The
focus should be adjusted for the average distance from the working piece. A camera
with automatic adjustment of the focus is not recommended, as the ever-changing
scale increases the problem of a correct recognition of patterns.

Corner-Recognition

To achieve good results when using the corner recognition of material, keep the fol-
lowing Tips in mind:

* the camera has to be focussed on the material surface, not the background
(which might be considerably lower)

* asharper image goes hand in hand with better results

* too much, especially dark shadow, can influence the results and may even shift
the recognized position towards the shadow!

* On the other hand, reflections from the material may influence the reliability
of the recognition.
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2.5.6 Summary of the Steps

1. Place Reference-Markers on a separate Camera-Layer. The positions of the
markers define then target net for the translation. If the camera layer exists, the
Camera Panel will open.

2. Place Working Piece on the machine. The direction should be approximately
correct.

3. Using the Control-Panel, move the First Marker into the Camera-Image.

4. Click on "Define Pattern”, to define the pattern, highlighted by green Crosshairs.

5. Click "Define First Marker”, to tell Cenon that the first marker is in the camera
view. The Camera-Drive will start to collect all the other markers, providing
the actual points for the Markers defined on the Camera-Layer.

6. After all deviations are collected, the transformation net is complete. You can
check the transformed output paths on your screen by enabling the output paths

in the Layer-Panel.

7. Start the output by pressing ”Start” in the Control-Panel.

Note: the crosshairs in the graphics window are ignored for the camera. Origin of
the output is the first Reference-Marker.

2.5.7 Tips

* Turning off the camera layer (closing the eye in the layer panel), stops the de-
livery of images from the camera. This can come in handy on slow computers
to regain full power, if needed.



2.6. PROTOTYPING OF CIRCUIT BOARDS (PCB) 61

2.6 Prototyping of Circuit Boards (PCB)

This tutorial describes the process of making a double sided circuit board. The steps
include export of all data from your PCB layout software, importing the data, en-
graving the insulations, drilling, cutting of the contour, etc.

1“ i ‘
&

Bt

When editing with Cenon, there are often several ways to achieve the same thing. In
this tutorial we will try to point out some of the different approaches, even if it makes
the tutorial a little longer.

2.6.1 Export

Before you can start, you have to export the data of both layers, the drill data, and
the contour of the board. The following table recommends export formats.

‘ Data ‘ File Format ‘

Layers Gerber, EPS

Drill Data | Excellon, Sieb&Meyer
Contour Gerber, EPS, HPGL
Logo/Text | Gerber, EPS, HPGL

If possible, you can include the Contour Layer on the Soldering Layer. This will save
you one Import step.

2.6.2 First Steps

We start by opening the template file "PCB-Template.cenon” from the path “/Li-
brary/Application Support/Cenon/CAM/Jobs/PCB”. You can use the Open-Panel (Menu:
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File > Open...), and click the Goto-button "Examples” to jump to the Cenon-Library.

LA Open
(il = = 3
<[ »] (52 = ) (G@rce # @
DEVICES , BatchExample.cenon = " ‘Dema.cenon
» 9% Camerak...ple.cenon % Demol.cenon
> SHARED % CNC-Dire...le.cenon a on |
PLACES . Embedde...ple.cenon %, PCBVorlage.cenon
%% EyeCatcher.cenon
ESNAGH IR % Front.cenon
L) Yesterday % Gear.cenon
(1) Face Week M Inlay.cenon
(L) Today (] PcB >
(2] All Decume. .. (& Pickout
Arta s E :f:sz.(enon ;
1 photes Az =
Goto: Examples | Home Library | Documents |

(Gancel)
(Cancel)
~

The Template file is a rather empty document. All you can see is two fitting pins.
However, almost all settings, you possibly need to make a circuit board are prepared
for you. Using the Template saves a lot of time.

Document Size

The Template Document provides a file size appropriate for boards of up to about
160x100 mm. You can change the Working Area in the Working-Area Panel to fit
your layout, Menu: “Format> Working Area ...” (See section 3.3.2).

™ 7 7 Working Area

B
Width [mm]: EQOO

Height [mm]: 150

Save a Copy

Now, before you do anything else, save your document with a new name !

From the Menu pick, File>Save As ... The Save-Panel appears and lets you chose a
location and Name for the file. We recommend to save files to your private Library-
or Documents folder "THOME/Documents/Cenon/Projects”.
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The Layers
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The PCB Template provides all layers you may need to assemble single- or double-
sided circuit boards. The following table gives an overview of the layers provided by

the Template.

Layer Purpose ‘ Source ‘ Tool

Contour The contour of the board. This layer is cut out Imported in EPS or | PCB
and has to provide a filled object (Path, Gerber, format, or Cutter
Rectangle, Circle). created in Cenon.

Soldering The Soldering Layer. This layer provides the Imported, usually Insulation
soldering data and calculates the insulation as Gerber file Graver
engraving.

Blow-Up Widens the insulation channels to make soldering | Calculated from Rub-Out
easier. The channels will only be widened where | data on Soldering Cutter
the distance allows widening. Layer

Rub-Out Areas wherein all surplus copper is removed. usually created in Rub-Out
This layer has to provide a closed shape covering | Cenon, calculated Cutter
part of the board. If you rub-out the entire board | from soldering
no Blow-Up is needed. layer

Component | For double sided boards. This layer calculates Imported, usually Insulation
the insulation engraving. as Gerber file Graver

Blow-Up Widens the insulation channels. Calculated from Rub-Out

Component Layer Cutter

Rub-Out Areas wherein all surplus copper is removed. created in Cenon Rub-Out

Cutter

Fitting Pins | Fitting pins are needed for double-sided boards modified in Cenon Drill
only. They help to flip the board before
machining the Component Layer.

Additional layers can be added as you see fit, for example a layer to engrave a logo.
For Drill Data a new layer can be created automatically for each imported drill diam-

eter.

The tools will be explained in detail before we start machining.




64 CHAPTER 2. CAM WITH CENON

2.6.3 Import

After the data is prepared and the template document is loaded, we can now import
the various files to their layers.

This tutorial is using the Example files from the folder “’/Library/Application Sup-
port/Cenon/Examples/Demo2”. The board we are prototyping serves as the LED
board of a well-known CNC-Controller:

Nicg 2
3
'Arig.. %)
°
Ly Yy Ems
"“. tus rg‘f:r
3 ‘H Y s, .
'\3‘ a't Y]
®
) Ry

Import Soldering Layout

Please go to the CAM-Panel and pick the Tab "Layer”, which brings you to the layer
management. Now select the Layer to which you want to import. In our case this
is the Soldering Layer. The Panel should look like below with the Soldering Layer
selected.

U CAM Panel

fLaver Magazine Control | Positions |

| vhfiso-Cutter :] 01 | DIspIayGraphIcE
'@/ B W 16 Contour PCB-Cutter 2.0 mm Display Output |_|
&7 0.1 Soldering vhf Iso-Cutter

&~ 0.1 Blow Up vhf RubOut 0.5 mm

&7 0.1 Rub Out vhf RubQut 0.5 mm
&7 0.1 Component vhf Iso-Cutter

&~ 0.1 Blow Up vhf RubOut 0.5 mm

&7 0.1 Rub Out vhf RubQut 0.5 mm e
&y 1.6 Fitting Pins Drill 3.0 mm (_Moveto Layer )
g Clipping (-—\

Show Details .. |

f 7. N\
Mew Remove |
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When the layer is selected, go to the File-Menu and pick File > Import. The Import-
Panel (below) appears. Here you can chose the data file providing the soldering data.
In our example this is SL.ger, a Gerber file (RS 274 X).

In the Pop-Up Menu in the lower part of the Import-Panel, you can chose an import
location. We want to import to the ”Selected Layer”. That’s why we selected the
layer within the Layer-Panel.

OLR Open
[« »][s2 =|m) ([JDema2 B a
» DEVICES 1 5Lger | Preview:
SHARED el
ww Contour.ger
» PLACES UM excellon.drl

E—e
» SEARCH For | 5] LEDsJpg

W Tutorial.cenon
» MEDIA

Name 1 _Sl.ger
Kind Gerber
1 Size 20 KB on disk i

Importto

| Selected layer [ :»]

¥ Selected layer

—0 Mew layer(s)

=

{ Cancel |} [ Open ) P Existing layer(s}
s

After you press the button “Open”, the file will be imported to the selected layer, the
Soldering Layer.

Tip: There are other ways to import a file, for example, it is also possible to
move the Gerber-File from the Finder window into the Cenon document.
The file will then end up on the first visible (open eye &) and editable
(pencil #) layer (from the top of the layer list).

You can now move the imported file to a better location within the document. We
strongly recommend that you set a grid to make it easier to handle the imported data.
You can use the Grid-Panel (Menu Format> Grid> Set ...) to set a grid of lets say
1/10 Inch.
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Tip: If you group your layer (select all elements of the soldering layer and pick
Edit> Group from the Menu), you can grab the entire group at any desired
pad and move this pad to the grid. The entire group follows and is now
aligned to the grid !

After this step your Document should look something like the following:

MAAM % Tutorial.cenon

.

X: 85.0148 Y: 29.8685 Wi4.2333 H: 230481 [mm (3] (@[ 150% (] +]

.[1. }
. @by LED-Display vi1

1 1dy
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Import and Alignment of Component Layer

The Component Layer is imported in the same way. In the Layer-Panel select the
Component Layer. Then open the Import-Panel and pick the data that should go to
the Component Layer.

This could end-up something like this:

The Component Layer might end up in a different position than the Soldering Layer.
Of course, we need both layers fit exactly on top of each other, which is easy to do.
You have several options:

1. Make sure all data of the Component Layer is grouped (Select all elements and
go to the Menu: Edit> Group).
Grab one Pad from the Component Layer and move the entire group on top of
the soldering layer. The group will snap (at the position of the pad you grabbed
it) to the grid and to elements of the soldering layer.

2. Before you use this way of aligning layers, make sure you are able to select
elements on non-editable layers. If you can’t, go to the Preferences (Menu:
Cenon > Preferences...). In the General Preferences check the switch ”Selec-
tion of non-editable layers”.

Now make sure neither the Soldering Layer nor the Component Layer is grouped
(Select the elements on each layer and pick Edit>Ungroup). Otherwise you
are not able to select a single element, which we have to do.

Make sure the Soldering Layer is not editable (broken pencil in Layer-Panel).
This means, the other layer will be moved later to fit on this one.
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On the Soldering Layer, select a pad that is also available on the Component
Layer. Select the same Pad on the Component Layer.

Open the Transform Panel from the Menu: Tools> Transform Panel ... and
click the Align Icon on top of the Transform Panel.

Make sure the ”Align Layers” Switch is active !

Now align Horicontally and Vertically by pressing the center Icons of both

TOWS.

- " Transform
a0 5 G
Align

Haricontal
= = (=
= = &3
e — ——— | e—
Vertical
%0 (050 f
(55 (20 (0

™ Align Layers

Now, both layers are perfectly aligned:

Tip: To avoid moving elements accidentally, we should protect the layer by
making it non-editable. If you click on the pencil icon of the layer, the
pencil will be broken and the layers can’t be edited any more.
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Import Drill Data

We can load drill data from several different formats, like Excellon, or Sieb&Meyer.
In most cases the format will be recognized automatically. Other formats based on
the ISO, DIN, G-Code standard should work as well.

Open the Import-Panel (Menu: File > Import) and pick your drill file. The file needs
the extension .drl to be displayed.

In the Pop-Up menu in the lower part of the Import-Panel select "New layer(s)”. This
will make sure we get a new layer for each tool (drill diameter). Every layer gets an
appropriate name including the diameter of the drill.

~ s
(«7» ] (52 = i) (& Demo2 B a
DEVICES = 1 SL.ger [ ¥ rreview:

wiwr 2 Cl.ger

* SHARED

* PLACES

» SEARCH FOR

E . | D I N
= iri |
W Tutorial.cenon

Name excellon.drl i
Kind DIN data ¥
1 Size 4 KB on disk i

> MEDIA

Importto

| New layer(s) hd

“

Again it can happen that the drill data is not aligned with the rest of our layout. In
the same way as we have learned for the component layer, we can now align the drill
data of each drill-layer with the Soldering Layer.

The images show our drill data before and after alignment.
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And this is how the Layer-Panel looks like. There are 4 more layers with the drill
diameters.

U CAM Panel

f Layer = Magazine  Control = Positions

| Drill 3.0 mm = ] AIU 5 DIspIayGraphIcE
w4~ { @ 1.6 Contour PCB-Cutter 2.0 mm Display Output |_|
& = 0.1 Soldering vhf Iso-Cutter

e 0.1 Blow Up vhf RubOut 0.5 mm

= 0.1 Rub Gut vhf RubQut 0.5 mm Baore 0.6 mm

g 0.1 Component vhf Iso-Cutter

L 0.1 Blow Up vhf RubOut 0.5 mm

g 0.1 Rub Qut vhf RubOut 0.5 mm

& =~ 1.6 Fitting pins Drill 3.0 rmm { Moveto Layer )
&8 H0 Boredb6mm —_—
&y~F B0 Bore0d.9mm (" Show Details ... )
@B B0 Bore24mm — =
&,~@ B0 Bore3.5mm (New ) [ Remove )

5
P
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Import and Editing of Contour Data

We only have the contour left to do. Let’s try a different appraoch.
Make sure the Contour Layer (top layer in the layer list) is editable. In the Finder
window, locate the Contour file and drag it into your document. Voila:

=
=

]

=

|;_:.

.|_$_I. i ..:I. Hlfl':”:'Ll Hlfl ik

I l _"-- LED=—Dhiemieny 41 1 . .'
wam Ir : JEDC eoezer )|

But ouch, there is a lot of stuff, we don’t need. All we need is the rectangle. Some
elements are not even in our working area, hmm. No big deal.

—J whi laktronik GeibH ]

Select the group that has been imported by clicking on any element of the Contour
Layer.

Go to the menu and pick Edit> Ungroup (or Cmd-Shift-G). All ungrouped elements
stay selected.

Now, while holding the Shift key pressed, select the lines forming the contour (or
use Shift and the Drag-Select). This will deselect the elements of the contour. If you
hide all other layers (close the eye) this is easy to do.

All elements that are still selected can go. Simply press the Backspace key and these
elements are gone. All that’s left now is your contour elements.

Tip: If you accidentally lose the selection after the ungroup, you can always use
“Edit> Select All” to select all elements on visible (editable) layers, even
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elements outside the working area. You don’t have to adjust the size of the
working area to fit all elements. Make sure only elements on the layer(s)
you want are being selected.

What we have now should look something like the following. Our contour layer is
not aligned and consists of four single lines. What we need is a closed path or a
rectangle.

To turn the single elements into a Path, we first select all of them. We will show two
ways how to select all off the single elements.

1. While keeping the Shift key pressed, click every single line once until all are
selected (knobs are displayed). You can also use the Drag-Select.

2. Hide all layers except the Contour Layer and pick Edit> Select All.
Then go to the Menu and pick Edit>Join.

Tip: We can test if we did a good job by deselecting the Path (click beside
the Path) and then selecting it again. If something is not selected or the
Menu item Edit> Select All is still active, then we have to join the missing
elements too.

Next we align the contour layer by moving it to the grid or use the Transform-Panel
to center it.
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We are not done yet. We have to fill the contour to allow the tool radius compensation
to do it’s job.

Select the contour, go to the Inspector Panel and chose a basic Filling. Also make
sure that Stroke is off (stroke width = 0).

SOEve S v

| Basic '»5*] | Not Stroked r-1"$*'] [
Color Color
— [— |
Graduate Color _Width —

0 (—)

Advice: It is better to include the Contour Layer in the data of the Soldering Layer
or Component Layer. Then you don’t have to import the Contour Layer
at all, simply move the elements from the Soldering Layer to the Contour
Layer. To move the elements to another layer, simply select what you
want to move, switch to the Layer-Panel and select the Contour Layer.
Now press the button "Move to Layer” - that’s it. Both layers have to be
editable.
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Creating a Rub-Out Area

There is nothing to import for a Rub-Out area. All we need is a closed graphics
object, like a Rectangle, Circle, or Path. Make sure the Rub-Out layer is the only
editable layer, when you start creating graphics.

Positioning the Fitting Bolts

The Fitting Bolts are needed for double-sided boards only. They make sure that you
can flip the board precicely.

Basically the fitting bolts can be located anywhere, even within the contour of the
layout.

A reasonable location is to the right and left of the contour.
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2.6.4 Pre-Manufacturing
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This part will explain the settings of the layers (manufacturing steps), assigning tools,

etc.

Most of the settings are preset in the template, some need to be set by yourself.
The table shows an overview of the layers, the strategy needed for their purpose, and
a suggestion for the appropriate tool.

Layer / Step | Strategy / Compensation ‘ Tool

Contour Outside tool radius compensation. For GRP/CRP Cutter or
double-sided boards, this layer should be Double-Tooth Cutter
mirrored, since it is the last thing to do after we depending on your board
flipped the board. material.
Soldering PCB Insulation. All electric potentials are Insulation engraving tool.
separated, even if tracks have to be tightened to
achieve this with the given tool.

Blow Up PCB Blow-Up. The insulation paths are widened. | Rub-Out Cutter or other
In narrow areas, the tool is going only as far as the | cylindrical tool
space allows.

Rub Out PCB Rub-Out. All surplus copper will be Rub-Out Cutter or other
removed. If you rub-out the entire board, there is cylindrical tool
no need for a Blow-Up.

Fitting Bolts | None Drill with the diameter of an
available fitting bolt (even the
shafts of broken tools can
serve as fitting bolts).

Bore None Drill

Logo/Text None or Inside compensation Insulation cutter or engraving
tool

The PCB Template has the default PCB magazine assigned, which contains tools
suitable for prototyping circuit boards.
For each layer you have to assign an appropriate tool. If you have to modify or
add new tools to the magazine, you can do this in the Magazine-Panel. The sec-
ond Tab in the CAM-Panel brings you to the Tool-Magazines (see section 3.4.3 and
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section 3.4.4).
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Finally, below you can see how the fully assigned Layer-Panel gives you an overview
of all settings and assigned tools.

o TalG

CAM Panel

{ Layer I Magazine  Control = Positions

| PCB-Cutter 2.0 mm

:] A 16 ~r  Display Graphic (¥

=== [ M 1.6 Contour
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& = 0.1 Soldering vhf Iso-Cutter

e 0.1 Blow Up vhf RubOut 0.5 mm

g 0.1 Rub Qut vhf RubQut 0.5 mm

e e 0.1 Component vhf Iso-Cutter Contour

e 0.1 Blow Up vhf RubOut 0.5 mm

= 0.1 Rub Qut vhf RubQut 0.5 mm

& = 1.6 Fitting pins Drill 3.0 mm (m-\!
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Special settings of Layers

Contour Layer:

Bore Diameter:

If you make a double-sided board, it is important to mirror the
Contour-Layer. Select the Contour-Layer and click on the but-
ton ”Show Details”. In the Layer-Details, the Switch ”Mirror”
has to be active. There is no visible change in the display, but
the output will be flipped (about the fitting markers) to fit the
component side.

' Outside i Fill |
error@
Dip Depth: 1.6
Approach ®: 0

You have to assign a drill from the magazine of appropriate
diameter.

You also have to set the dipping- or immersion depth of the
drills.
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Soldering Layer,

Component Layer:

Fitting Bolts:

Results

If you encounter issues with the calculation of your imported
data, you can switch to a second algorithm, which is more tol-
erant with bad data.

In the case of our Component Layer, for example, the fillings of
the ground areas are endless overlapping lines which criss-cross
all over the board. If we are in control, we can export better
data. Otherwise, go to the Project-Settings (see section 3.2.1),
select the CAM-Settings from the Pop-Up, and check the Switch
”Use Raster Algorithm”.

There is a second setting "Deburring of PCB tracks”, which
will remove chips that could stay attached to the copper in tight
corners.

You can adjust the fitting bolts as you wish. They can even re-
side within the contour of your layout, if you don’t mind the
wholes.

A good location is just outside the contour, to the right and left
of the board.

The fitting pins are only needed for double-sided boards to al-
low flipping of the board precisely.

We are ready. Here is a display of the output tracks of the major layers.
You can also display the tool diameter for the display of your output. You can enable
this in the Menu: Display > Show Tool Diameter.
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Contour Layer:

Soldering:

Blow-Up:

Rub-Out:

N Y Y A |
) —
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2.6.5 Tools for Prototyping
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In this section we will introduce the carbide-tools applied for prototyping of circuit

boards.

‘ Insulation Engraver

‘ Rub-Out Cutter

| Drill

| GRP/CRP Cutter

/)

>

4

This kind of tool is
applied to engrave the
insulation tracks.

The tip of this tool is
tapered from 0.05 to
0.7 mm with a tip an-
gle of 90°.

The tool is also well
suited for general en-

graving tasks.

This is a shortened
double tooth cutter,
which reduces the risc
of fracture. It is used
for the Blow-Up and
Rub-Out.

This tool is an all-
rounder and a perfect
engraving tool in gen-
eral. It is as well
suited for levelling the
run-out material, and
for cutting the contour
of low-quality circuit

boards.

Carbide-Drills are
used for all bore-holes

we have to drill.

These PCB cutters
are  available as
spiral-toothed or
diamond-toothed.

They are  made
for cutting highly
abrasive material
like fiber-reeinforced

circuit boards.

If you don’t use an automatic tool changer, make sure all tools are equipped with a
stop ring. The ring makes it a lot faster and easier to change and adjust the tools.

You can obtain these special tools in the vhf Tool Store. Tools will be shipped inter-
nationally within a few days.
http://www.vhf.biz/tools.
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Most tool parameters are pre-set in the PCB tool-magazine coming with Cenon. If
your spindle is not capable of the high revolution, you have to reduce the lowering

speed and feed accordingly.

Recommended tool parameters for drilling:

‘ Diameter ‘ Revolution [rev/min] ‘ Lowering Speed [mm/s] ‘

0.5 mm 60.000 25
0.6 mm 60.000 30
0.7 mm 55.000 35
0.8 mm 48.000 35
0.9 mm 42.000 35
1.0 mm 38.000 35
1.1 mm 35.000 35
1.2 mm 32.000 35
1.3 mm 29.000 35
1.4 mm 27.000 35
1.5 mm 25.000 35
1.6 mm 24.000 35
1.7 mm 22.000 30
1.8 mm 21.000 30
1.9 mm 20.000 30
2.0 mm 19.000 30
2.1 mm 18.000 25
2.2 mm 17.000 25
2.3 mm 17.000 25
2.4 mm 16.000 25
2.5 mm 15.000 25
2.6 mm 15.000 25
2.7 mm 15.000 25
2.8 mm 15.000 25
2.9 mm 15.000 25
3.0 mm 15.000 25
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2.6.6 Manufacturing

Now we are prepared to machine the board.

Levelling the machine

For perfect results of the insulation engraving it is crucial to have the machining area
leveled. There are several ways to achive this. We will just hint at two possible
options:

1. Use Leveling to measure the machining area and let the CNC-Controller com-
pensate inaccuracies in Z. Even better is to level the surface of the base mate-
rial. See section 3.5.3 for more information.

2. Use a cylindrical tool of sufficient diameter to level a good part of the machin-
ing area. Mount a running-out material (for example an acrylic board) to the
machine table. This material can now be leveled and used to attach the circuit
board. In Cenon you can simply create a rectangle with a standard filling. The
run-out material is needed anyway to protect the machine table from damage
while drilling or cutting.

Mounting the base material

First, we tape double-sided adhesive film (DX1) to the base material. We remove
the waxed protection-paper and make sure, we have no bubbles trapped under the
film. Then we remove the second protective-film and tape the board onto the run-out
material.

Another option is to use a vacuum table.

Start-Position

The first step is to move the machine to the starting position. The Start-Position is the
position on the machine reflecting the location of the cross-hairs in your document.
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In our example the Cross-Hairs are in the lower/left corner of the board.

In the image below we see the cross-hairs. Additionally we see the output displayed
with the effective tool diameter (Menu: Display > Show Tool Diameter). This lets
you anticipate pretty well the expected results after output

AnNA . Tutorial.cenon

X: 1035403 Y: 70.3791 W: 209903 H: 400403 | mm % (&](-)[200% Feil( <)

You set the Start Position in the Control-Panel.

! CAM Panel
| Layer = Magazine | Control | Positions |
Start Positlon O
-
1) r (—\‘ ‘.
x[iod_]4 > Cravament) (Clssin
3 b ——— | || Suetion
¥i 50 4 ) (" Home
[z |5 N
Mave Height: 1 i, GL)
{ Get ) [ SetPosion ) @A
() Selection
Tool: vhf isofrdser 0.2 mm
Offset 0 ( Start )

The X and Y positions are straight forward, simply move the machine with the help
of the arrow keys to reflect the position of the cross-hairs in your document window.



2.6. PROTOTYPING OF CIRCUIT BOARDS (PCB) 83

Partly visible gray lines in the Graphics window also show the machine boundaries
relative to the Layout.

Each click on the arrow key will move the machine by 1/10 of the unit. If you keep
the Control-Key pressed while clicking, the machine moves a full unit.

Now enter a Move Height, that you wish to maintain, lets say 1 mm. This is the
Minimum Safe Altitue to fly.

Finally we have to exactly adjust the Z location.
First, we can roughly move Z down to a safe distance above the material.

1. Now, if you happen to have a surface sensor, use it.
Activate the Adjust Switch (to the left of the Z position) and move X and Y
above the base material (or contact plate).
Press the arrow for Z down.
The Z axis should lower until it touches the contact or circuit board, depending
on the kind of equipment. you use.

2. Here is the manual approach.
Activate the Adjustment Switch and move X and Y above the base material.
Lower Z with smallest (0.1 mm) steps until you can still see a little gap between
the tool and the surface.
Place a piece of thin paper between the tool and the surface of the board.
Lower Z until the paper can’t be moved any more. Stop here, that’s our Z-
position !

See section 3.4.5 for details.

To avoid engraving too deep, it is advisable to try with a Z position of about 1/10 or
2/10 mm higher first. Start engraving the Soldering Layer as a test. Stop the machine
after some engraving and decide wheather the insulation channels are right. Adjust
Z, if necessary in small steps of about 0.02 to 0.05 mm.

Order of Output

Layers are usually processed one by one. To select layers for machining open the eye
of the layer(s).
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The following list shows the order of output steps for a double-sided board:

1.

8.

Drilling of the bore-diameters

2. Dirilling of Fitting holes for fitting pins

3. Engraving of the Soldering Layer

4. Engraving of the Blow-Up and Rub-Out of the Soldering-Layer
5.
6
7

Flip the board

. Engraving of the Component Layer (mirror switch on)

. Engraving of the Blow-Up and Rub-Out of the Component Layer (mirror switch

on)

Cutting of the Contour Layer (mirror switch on)

The following list shows the order of output for a single sided board:

1.
2.
3.
4.

Drilling of the bore-diameters
Engraving of the Soldering Layer
Engraving of the Blow-Up and Rub-Out of the Soldering-Layer

Cutting of Contour Layer

For every tool change, the tool has to be adjusted. While this has to be exact for
engraving tools, the drills and cutters are easy to adjust and should fit well enough
by using distance rings on the tools.

Advice: To avoid a “running off” of the drills when dipping into the board, it is

advisable to use a run-in material, placed on top of the board. Pressboard
or resin board are good material. Make sure you drill deep enough into the
run-out material to get clean holes.

Advice: In order to achieve a high lowering speed for drilling and avoiding accel-

eration ramps within the drilling process, set the Move Height generously.



Chapter 3

Reference part - the functions of
Cenon

3.1 Preferences settings

You can reach the preferences panel with the menu entry ’Preferences’ from the
menu 'Info’. Here you can set basic settings for Cenon and its modules. The Cenon
preferences are placed in different tab pages, which can be selected by the row of
icons on top. The icon to set the CAM preferences displays a CNC machine.

Astro
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3.1.1 CAM Preferences

8006 Cenon Preferences

Device for Output

; HP7550 r:]

| Fractal Steps (experimental) _

" Enhance frakial Steps SHUSEIERROEL At Siacip E
) Fracial Steps Use Raster Algorithms [
Return to parking position ||

Increment Serial Number @

Optimize Moves ||

Chamfering of PCB tracks ||

Device for Output

: CAM100-SF |+]

In this pop-up-menu you have to select the appropriate parameter-file for your ma-
chine. Please have a look at section 4.2 for the creation of your parameter-files or the
adaptation of existing files.

Show CAM-Panel at Startup W

This option determines, whether the CAM panel will be displayed at start-up of the
application.
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Use Raster Algorithms [_|

This uses raster algorithms to render the output paths. This takes more time and is
usually of less quality. However, if you have extreme data, this option will calculate
what the normal algorithm can’t.

Return to parking position ___
Here you can enter whether the machine should move back to the starting position
after the output of your data or not. Otherwise it’ll stop at the last entered coordinate.
Increment Serial Number (W1
Enable this entry, if you want Cenon to increment your serial numbers automatically
after each output. This works for batch production as well as for single peaces.
Optimize Moves ||
If you enable this option, the moves between the objects are optimized automati-
cally. As this prevents yourself of adopting your own order, you can disable this

feature. You will still be able to let Cenon optimize the moves by using the menu
entry (Format> Optimize Moves).

Chamfering of PCB tracks ||

If this switch is activated, the isolation tracks of PCB prototypes will be deburred.
This means, that tiny copper chips are removed at positions with sharp angles.

3.2 Project Settings

The Project Settings of Cenon allow every Document to have its own settings. This
way one document can be in the unit Millimeter, while the other document is mea-
sured in Inch. Or one Production-Job can be calculated with Raster-Algorithms, and
it’s serial number is increased after each output.

The Project-Settings of Cenon are located in the Info-Menu right below the Prefer-
ences.
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e[, File Edit

= AL

|  About Cenon ... |

Preferences ...

Project Settings ... 385
License ...

Services [
Hide Cenon 3£ H
Hide Others

Show All

Quit Cenon #E0

3.2.1 CAM-Settings

The CAM Settings allow each document to have different settings than the CAM-
Preferences.

AN Project Settings
| CAM Settings 4
X Use Preferences Settings | |
fjj Use Raster Algorithms [
c AF; Return to parking position |

Increment Serial Number @
Optimize Moves | |
Chamfering of PCB tracks ||

Use Preferences Settings The settings from the Preferences Panel are used
(Default)
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Use Raster Algorithm As described in the corresponding entry of the
Preferences Panel, Raster-Algorithms is given the
priority over Vector-Algorithms. Raster-Algorithms
may have advantage in calculation of critical graph-
ics. So if the Vector-Algorithm fails, try the Raster-
Algorithm.

Return to parking position After each output, the machine will return to the
set parking position. Also see the correspond-
ing entry in the CAM-Settings of the Preferences
Panel (section 3.1.1).

Increment Serial-Number After each output, the serial number will be in-
creased by one. Also see the corresponding en-
try in the CAM-Settings of the Preferences Panel
(section 3.1.1).

Optimize Moves The moves between the parts will be optimized
automatically. Also see the corresponding entry in
the CAM-Settings of the Preferences Panel (sec-
tion 3.1.1).

Deburring of PCB tracks For insulation engraving of Printed Circuit Boards,
critical edges are deburred. Also see the corre-
sponding entry in the CAM-Settings of the Pref-
erences Panel (section 3.1.1).

3.2.2 Camera-Settings

With the help of the Camera-Gauging, it is possible to automatically recognize the
placement, rotation, and deformation of a working piece. Applications are in com-
bining different technical steps, like processing screen-printed Front Panels or cutting
Large Scale printings. Also in cases where the placement on the machine is not ac-
curate.

The Camera-Settings are only active, if the Camera-Gauging has been licensed.
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T i) Project Settings
[ Camera Settings ..;.]
/ Working mode | Gauging via Markers :]
M Color mode | Black on white ikl
Camera :
Camera Offset Pattern Type ' Any 3]

"
Ea—

Search second Marker within Angle

define unrecognized markers | |
Transform without Scaling ||

get Markers from Image

o oY

=

45 Ii Return to Defaults :l
s

The Camera-Settings allow the configuration of the camera-function and alternating

parameters.

Working mode = Gauging via Markers b5 ]

The Working Mode determines how to use the camera:

Gauging via Markers

Corner Recognition

The working piece will be measured with the help of
Reference Markers. It works as follows: One set of
markers is attached to the working piece for example
by printing. The corresponding set of markers, has to
be placed on the Camera-Layer of the Cenon-Job. Af-
ter recognizing the real marker positions on the working
piece with the camera, the output can be transformed to
fit the working piece.

The Corner Recognition is used to find the crop marks
of a working piece, for example to automatically cut out
printed items.

The corner points are placed on the Camera-Layer, as
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Place Prototypes

described above for the gauging via markers. The iden-
tified corner points will be connected to a filled path and
placed on a layer.

If the pattern type "Corner” is selected (see below), than
the pattern of the corner will be rotated by 90 degrees
after each recognized mark. Thus, the number of corner
points is limited to four. Starting point must be the lower
left corner of the working piece.

The Graphics placed on the Prototype-Layer (see Sec-
tion 3.4.2) will be placed at the position of each recog-
nized marker.

Color mode | Blackon white

-

Black on White

White on Black

Markers are a dark pattern on bright background

Markers are a bright pattern on a dark background

Pattern Type | Any

|;!

Only connected patterns are recognized. However, small gaps are tolerated.

All

Circle

Cross

Everything is accepted as pattern, as long as it resembles
a connected structure of sufficient size, e.g. every hair.

An accepted pattern has to look similar to a circle. The
circle is tolerant to rotation, and works very well with
rotated working pieces.

The pattern has to be a cross. A cross is not tolerant to
rotation, this means that it may be necessary to define the
pattern anew for every new placement of material.
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Corner This pattern type is active in the working mode “Corner
Recognition” only. The defined pattern will be rotated by
90 degrees after each recognized corner. Only 4 markers
are allowed in this mode.

Material Corner Only active in the working mode “Gauging via Mark-
ers”. The orthogonal corners of the material (ex. front
panels or printed circuit boards) will be recognized. Ma-
terial corners need no definition of the pattern.

define unrecognized markers [_|

If this switch is checked, you can define positions of markers manually, if they
haven’t been found by the Camera.

In case a marker has been missed, a Alert-Panel appears. If you confirm this Panel
with OK, the button ’Define Point” in the Camera-Panel is activated.

Now, you have to move the Marking into the center of the camera view. Then you
can set the position by pressing the button "Define Point”.

Transform without Scaling | |

If this switch is checked, the transformation is limited to location and rotation (no
scaling/stretching) of the objects recognized by the camera. This is important when
exact size matters, for example when cutting front-panels and inlays. This transfor-
mation needs at least two markers to determine position and rotation of objects. If
more than two markers are given, the average of all measured markers is used to
determine the rotation.

Search second Marker within Angle

0 0® A 45"

For strongly rotated working pieces it may happen that the second reference marker
doesn’t appear in the camera view. In this case it is possible to search in an arc for
the second marker.

If the Search Angle is larger than O an automatic search for the second reference
marker will be started, if needed. If no marker is found, the point will be skipped.
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If the Search Angle is 0, then an Alert Box will appear for markers that are not
found. You have the choice to skip the marker, or to manually move the marker into
the camera view.
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3.3 The menus of Cenon

In this section we will describe the functions in the order of the entries in the menu.
When you look for a special information about a special entry you can surely find it

here.

| New .. BN

|
Open ... #0
Open Barcode ...
Import ...
import Text ...
Revert To Saved ... #U
Save 38Ss
Save As ... {r385
Print ... *P

Save Output ...

Open Barcode

Import Text...

With this menu entry you can load jobs via a code, for
example a barcode. The menu entry does only exist, if
the corresponding feature is configured. See section 3.7
for more.

Here you can load a text file. This can be used to produce
different signs of the same geometry in mass production.
The function is already explained in the Cenon Refer-
ence Guide.

The strings which are extracted from this file are dis-
tributed on Text graphics. Before you start to import a
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text file you have to place corresponding Text objects in

your project.
Sort rule:
Sl
| Mo character conversion s ]

In the Open-Panel for the text import you can select how
to sort the strings into your project’s Text graphics:
* row by row from the upper/left to lower/right
* row by row from the lower/left to upper/right
* column by column from the upper/left to the lower/right

* column by column from the lower/left to the up-
per/right

column by column from the upper/right to the lower/left

The file is a simple list of strings separated with a Space
character, Newline, or Tabulator (TAB). If you have space
in your strings you need to place the string inside double
quotes or use TABs to separate your strings (Is a TAB in
your text, TABs are used as the separating character):

text] text2 text3
or
"text 1" "text 2" "text 3"

If you have to insert a Newline or TAB in your strings
you can use ’\n’ respective ’\t’ in your text.

"Line 1\nLine 2" "Line 1\nLine 2"
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Tip:

* If the text you want to import is in a different for-
mat, the search/replace function of a common text
editor can help you a lot to change the formatting.

Save Output... Here you can save the data in a file instead of sending
the output directly to a machine. The same setting and
starting positions are used (as when you send it directly
to an output-machine).

3.3.2 The Format-Menu

Format MIDLE
| Font P
Text [ 2
Crid B
Bring To Front 368
Bring Forward 3 (

Send To Back #G
Send Backward a5 )

Working Area ... {r#A
Page Layout ... {+3P
Optimize Moves {80

Bring to Front

Send To Back With this menu items you can move objects to the fore-
ground or background. So you can influence the se-
quence of the display. When an object cannot be selected
because it is hidden, you can put on the others with this
command.
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Optimize Moves

Working Area...

The selected graphic object can be send all the way to
the back or front, or just a single graphic object further
to the back or front.

The order of the graphic objects determindes the order
objects are process on output. If you have enabled the
automatic optimization of the output tracks, these entries
are disabled! See section 3.1.1 for more info.

The moves between working pieces can be optimized.
Therefor the order of the objects is changes like with the
entries above.

You can display the moves with the Menu
Display > Show Moves.

The Working-Area panel appears. Here you can enter
the size of the working area. The measuring unit of the
size is taken over from the Preferences-Panel.

The working area is displayed as white background in-
side the Graphic-Window. If you open a new window,
the working area is preset to the size of the machine.

3.3.3 The Tool-Menu

The tool menu gives access to the different tool-panels of Cenon. Some items appear
only if the respective module is installed.
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Colors ... {+38C
Inspector ...

Batch Production ... {+3B
Transform Panel ... {+8F
Intersection Panel ... 3l
Vectorize Images ... {3V
CAM Panel ...

Teach In Panel ...

Batch Production... ~ The Batch-Production Panel appears. Here you can distribute
the graphic on the working area. The batch production is
already explained in detail in the Cenon Reference Guide.

CAM-Panel... The CAM-Panel of the optional CAM module appears. The
CAM-Panel is opened automatically after you have started
the program. It is used for the management of the layers and
tools and to control the machine. See section 3.4.

Teach-In Panel... The Teach-In panel of the optional CAM module allows the
collection of positions from a machine. You can position a
plotter or machine over a template using the Control-Panel
(section 3.4.5). The positions then can be captured into the
document as a mark via mouse click in the Teach-In Panel.

The collected mark objects can be converted to 2-D or 3-D
lines from within the Teach-In Panel.

3.3.4 The Display-Menu

The items of this menu gardly depend on the loaded modules.
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| Show Coordinates T®C |

| Show Directions 3D
Show Moves %M
Show Tool Diameter {#T

Show Directions

Show Moves

Show Tool Diameter

99

Here you can see the direction of the vectors dis-
played as little arrows on the border of the graphic
objects. The output usually follows the direction
of the arrows. Since, the quality of output de-
pends heavily on the direction of the processing,
you should have an eye upon this.

This menu item displays the moves of the mas-
chine between different working pieces. The moves
are displayed as blue lines.

The tool diameter used for output is displayed in
thickness of the output path. Usually the output
path is displayed with thin lines.
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3.4 The CAM-Panel

The CAM-Panel offers almost all management functions for CAM. With the different
areas the panel offers, you can manage layers, tools, positions, and you can control
the CNC machine.

ene CAM Panel
| Layer = Magazine Positions |-
Start Position O
=
= : - M
X: 0 4 b | Adjustment | [ Spinde
Y: 0 4 b | Home | | Suction
[ Jealy Al T
Move Height: 1 L
| Get || Save || Set | (o) Al
(| Selection
Tool: Mo tool selected
Offset 0.0 [ Start

In this bar you can choose the functions of the CAM-Panel like in an index-card-box.
Depending on your choice the look and the setting possibilities of the panel change.

You have got the following possibilities:

* managing of the layers (see section 3.4.1)

setting of further details to the layers (see section 3.4.2)

* managing of the tool-magazine (see section 3.4.3)

setting of the tool-parameter (see section 3.4.4)

control of the output and the machine (see section 3.4.5)



3.4. THE CAM-PANEL 101

* management of the position memory (see section 3.4.6)

3.4.1 Layers

Magazine @ Control  Positions |

The Layer-Panel is for the management of the different layers. The layers are used
by Cenon to separate the single steps (e.g. engraving and milling).

=) All

() Selection

Here you can choose whether you want to show the original graphic (tick next to
graphic) or the moving range of the tool (tick next to output) in the graphic window.
When the output is turned on a new calculation of the output path is started whenever
you change the parameter. To be able to work without any difficulties we recommend
to switch off the output while editing.

@/ B @0 Rechteck Single Tooth 2.0 mm
& 7 1.2 Airplane single Tooth 2.0 mm
& 78 HE0 Clpping Single Tooth 2.0 mm

This area is the heart of the Layer-Panel. Here you can already carry out most of the
settings for the layers with the small icons.

& = With the eyes you can switch on and off the display and/or the output of the
layer. A layer with closed/shut eyes is not displayed and output/given out. You can
use the little pencil to switch on/off the possibility to edit the layer.

7 & A layer with a broken pencil can not be edited and is therefore protected
against unintentional/unintended transformations/changes.

B £ Here you can choose whether the elements of the present layer are to be
filled or not during the calculation of the moving/driving/drive way. A bucket that is
poured out indicates that an element is filled so that the appropriate area is emptied
later during the engraving.
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In the two right images the element is filled in the two alternative ways (Standard or
Contour-Fill). The output path is calculated for a given tool diameter.

B N e you can select the kind of tool-radius-correction. You can choose
between the outward correction, inward correction and no correction and Pick-Out
(Carving). When you choose Pick-Out a new layer will be created for the filling.

On the left you can see a graphic that has been corrected outwards (miller-radius).
This operation is necessary when you intend/want to mill the graphic in its original
size out of the basic material. In the middle you can see an example for an inward
correction of the miller-radius. This operation is necessary when you want to engrave
the graphic into the basic material. No miller-radius correction is carried out in the
picture on the right. In that case the T would be reduced by its outer contour/outline
by the radius of the used tool during the operation.
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This is an example for the pick-out (Carving). You can only carry out the sharpening
with a conic tool. The sharpening is mainly an inward correction. But the tool is also
lifted appropriately in the edges and when the way is too small for the top/maximum
radius of the tool to make the picture as perfect as possible. This function is used e.g.
to create hobs. It’s very important to use the right tool when you sharpen to achieve
a perfect result.

Pick-Out: Further details you can find in section 2.3.
Here are some hints to achieve a precise and correct tool-radius-compensation:

* Use only curves that are simple. The more extreme a curve is the more in-
accurate its resulting contour. Connect curves tangential (connecting handles
should create a straight line).

right: wrong:
* A path must not have any gaps between the elements building the shape.

* You should not use too many elements to create a graphic.
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e If the tool is too big for the compensation, the outline of the graphics will not
calculated correctly.

Error messages that appear during the calculation of the drive way are displayed in
the console window of the workspace-manager.

1.2

This area shows the dip depth of the selected tools in this layer. The dip depth is the
distance that the z-axis from the scratch-height dips into the material (you can set
this in the machine Control-Panel (see section 3.4.5). The measuring unit is taken
over from the Preferences-Panel. Here you can see the name of the layer.

Airplane

You can enter the name into the edit-field on the right of the window. You get to the
panel layer-details with a double-click on this field (see section 3.4.1). You can set
further settings for each layer here.

Single Tooth 2.0 mm

Here you can see the name of the selected tool. The tool can be chosen with the
pop-up menu. with a double-click on this field you get to the Tool-Panel (see sec-
tion 3.4.4) where you can alter the parameters of the actual tool. When you move
the name of the layer with the mouse and by pressing the Ctrl-key at the same time
you can change the order of the layers in this panel and also the order of the display
and output. Cenon gives out the layers in the same order as they appear in the panel.
Therefore we recommend to work on engraving layers first and to cut the outline in
the last step.

| Single Tooth 2.0 mm 18

In this pop-up-menu you can set the tool for the selected layer. Here the tools of the
magazine that you have chosen in the magazine-panel are shown (see section 3.4.3).

& 12 |

Here you can enter the dip depth. The dip depth is the distance which the z-axis dips
into the material from the scratch-height on (you can set this in the machine-control-
panel). The measuring unit is taken over from the preliminary settings’ panel.
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| Airplane
Here you can see and edit the name of the selected layer.

| Move to Layer |

With this button you can move all the selected elements in the graphic window that
are on editable layers to the actual/present/current layer. You need this function to
separate the single operations.

| Show Details ... |

With this button you get into further panels where you can set further details that you
don’t need very often. (see section 3.4.2).

=1

This button creates a copy of the selected layer.

| New | |_' Remove |

Here you can create a new layer or delete/erase a selected layer.

3.4.2 Layer-details

Magazine  Control | Positions

Here you can enter further settings that you don’t need very often for the respective
layers.

| Standard Layer |,e.-§

Here you can set the type of the layer. The type is usually *Standard’. If you need
a special layer like a Fitting-Layer or a clipping layer, you can change the type of a
layer using this pop-up.
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Standard Layer The usual layer for all tasks, that are not special.

Fitting Layer On this layer, you can place markers for fitting bolts, allowing
the exact placement of material. As an example, this layer is
used to flip a dual-sided Printed Circuit Board to process the
second side.

Passive Layer This layer is dependent on a Standard-Layer. It can be cre-
ated automatically to contain Output-Paths, that need to be
processed with a different tool, for example using the Pick-
Out function.

Clipping Layer On this layer a Rectangle or Path can be placed to limit the
output area (ex: Panelling).

Template Layer Special Layer, for exmplae to place Prototype-Graphics, that
are later used for automatic output of multiples (see Sec-
tion 2.5 for an example using a Camera to recognize the po-
sitions for placement).

'Airplane

Here you can see and edit the name of the layer. This field has got the same function
as the editing-field in the Layer-Panel.

Fill [

Here you can switch on/off the filling. This button has got the same function as the
filling-icon in the Layer-Panel.

Mirror [

Here you can switch on/off the mirroring on output. Usually you will mirror your
graphic using the editing functions of Cenon. However, if you want to flip your
working piece during output (eg. for production of two layer PCB prototypes), you
only want to switch the output, rather the display.

The output will be mirrored by the axis between the two fitting marks on the Fitting-
Layer (see section 3.5.2).
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Dip Depth: 0

Here you can enter the dip depth of the tool in the basic material. The setting has the
same value as in the Layer-Panel.

Approach ®: |0

This field allows setting of an Approach Angle to smoothly approach the full dipping
depth. If you enter an angle greater than 0, the tool will approach the dipping depth
in this angle, until the full dipping depth is reached. The angular approach lowers
along the contour of the path - for a circle this would be in form of a helix.

The advantage of the angular approach ist a constant working speed, without stops
and unnecessary changes of the feeding speed. Consequently, ugly rattle marks are
avoided and the results get more beautiful. Also the tool is burdened less.

Special Behaviour:

Rubbing out a Circle If a circle is rubbed-out without angular approach, then the
Circle will be filled from inside to outside.
With Angular Approach, the circle will be filled from outside
to the center.

The Angular Approach is available for closed Paths, and otherwise ignored.

| Outside v

Here you can choose the kind of tool-radius-correction. You can choose between
several kinds of correction. The setting-possibilities correspond to the icons in the
layer-panel, but extend these for some special types of correction.
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‘ Correction ‘ Description ‘
Inside The tool radius will be corrected to the inside (Engraving)
Outside Correction to the outside (Cutting)

No side No correction at all
Pick Out For detailed engraving (see section 2.3)

PCB Isolation | Special correction of isolation tracks for PCB prototyping
PCB Blow Up | Special correction of Blow Up tracks for PCB prototyping
PCB Rub Out | Special correction of Rub Out for PCB prototyping

ﬁ_‘{_ Stepwise Z

First Step: 0
Step Size: 0.8 # 1
Final Step: 0.4

Cenon supports stepwise working of workpieces. Here you can enter how deep the
tool dips into the workpiece during the first operation and how the other operations
can be worked on at most and what should be leftover for the final operation. The
machine does not dip deeper than the maximum dip depth of the layer. With the
switch on the upper left you can switch on/off the stepwise working.

Settlement: 0

Here you can set a settling for the cutter. During the cutting of the settling only a
very small part of the material is removed to smooth the outlines. When the value
is not zero the settling is enabled, and the last run around of the cutting process will
remove the specified distance for the entire dip depth.

|Final Step: 0.4 -|

Settlement: 0 [-]

When this switch is turned on the settling is already inserted before the final step of
the stepwise operation. This can makes sense because the material might not cope
with all the forces of the settling when it is completely cut through.
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Fill Overlap %a: 25

Fill Direction: 0
[ Contour-Fill

I Reverse Direction
" Tinlay

E Use Layer for Batch Production

Here are more settings for the selected layer.

Fill Overlap %2: 25

Here you can enter the filling-overlapping. The filling tracks are closer to each other
by the appropriate percentage when you work with filling-overlapping than when you
work without it.

1 Contour-Fill

Activates the contour fill algorithm for this layer, and disable the Standard Fill al-
gorithm. The contour fill fills along the contour of the graphic, instead of moving
back and forth. The contourfill usually looks better than the Standard Fill, in some
situations like a filled circle, the Contour Fill is also faster.

Rose
2
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[T Reverse Direction

This command changes the direction of rotation of the objects on this layer. With
this function you can set the milling-direction for the output. Pay attention when
changing the direction of graphic objects manually (Cmd-d).

[ linlay

If you activate this option, the tool-radius correction is calculated in a different way:
Sharp angles are rounded so a outside correction would fit in a inside correction.

A successful calculation using the inlay option demands the right placement of ver-
tices:

In the left image the vertices are placed right. The angle for the inlay is calculated
correctly, and the result of the inner contour will fit inside the outer contour. In the
right image the correction for inlays fails. Always try to avoid vertices close to edges,
especially inside the tool radius!

This is a usual tool-radius-correction without the inlay option.

¥ Use for Batch Production

Here you can enter whether the layer should be used for batch production or not. See
also the description of the panel for batch production in section ??.
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3.4.3 Tool Management

{ Layer

Control = Positions |

The Magazine-Panel is for the management of the tools. Tools can be distributed on
magazines to arrange them for the different operation purposes.

Single-Tooth Cutter 1.0 mm
Single-Tooth Cutter 2.0 mm
Single-Tooth Cutter 3.0 mm
Single-Tooth Cutter 4.0 mm
Single-Tooth Cutter 5.0 mm
Single-Tooth Cutter .0 mm
Double-Tooth Cutter 1.0 mm
Double-Tooth Cutter 2.0 mm
Double-Tooth Cutter 3.0 mm

WO o0~ 3 B =

This list shows all the tools of the selected magazine. With a double-click on a
tool you reach the window where you can set the tool-parameter of the tool (see
section 3.4.4). When you move the tool name with the mouse and press the Ctrl-
key at the same time you can change the order of the tools and you can sort the list
according to the tool-types and sizes.

[ My Magazine 4

In this pop-up-menu you can select the magazine that you want to use for the ac-
tual/current/present graphic: The last entry of this pop-up-menu is for the creation of
a new (empty) magazine.

| Remove |

With this button the selected magazine is deleted.

Mame: My Magazine

Here you can enter the name of the magazine.
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| Tool Parameter ... |

With this button you get to the Tool-Parameters of the selected tools (see section 3.4.4).

Tool Info ...

With this button you can reach further tool-information in a later Cenon-version.

|New|

A click on this button creates a new tool and changes the appropriate Tool-Parameter
(see section 3.4.4).

| Remove |

This command deletes the selected tool.

3.4.4 Tool-Parameters

| Layer Control  Positions |

In this part of the panel you can set the parameters for the tool selected in the maga-
zine.

Mame: Single Tooth Cutter 1.0 mm

In this field you can see and edit the name of the tool.

! Cutter i‘d‘l‘i [ConicalCutter s ]

[ Drill ;-e-\] | Thread Gutter rn:;-u]

A tool can be used as a cutter, a drill, a thread cutter, etc. A drill can only be moved
up and down in the workpiece. A thread cutter is a special tool to cut threads.

Diameter (mm): 2 \~J ?
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Here you can set the diameter of the tool. Cenon calculates the output tracks with the
diameter.

The various fields for non-standard tools are described below.

Lowering Speed (mm/s): 3 4 b

Here you can set the lowering speed of the tool. The lowering speed is the speed with
which the tool dips into the material.

Cutting Speed (mmi/s): 10 4 b

Here you can set the cutting speed of the tool. The cutting speed is the speed with
which the tool is moved in(to) the material.

Adjust Z-Offset (mm): 0 A

Here you can set an offset for the z-height. This offset levels out tools that have
not the same length when you use tools with stopping ring. The proceeding is: first
you set the z-position in the Control-Panel for the longest tool. Then you can set the
Z-Offset for the shorter tools. When you press the adjustment-button the machine
follows your input, and allows for exact adjustment of the offset. When you switch
off the adjustment-button the machine moves back to the initial z-position. The offset
is saved then for the tool and during the operation this tool is lowered with the Z-
Offset added.

Revolution (1/min): 40000 4 D
Here you can set the number of revolutions of the spindle. When you have got a pow-

erful controller the number of revolutions is set automatically. Otherwise the value
can help you to remember which number of revolutions you have to set manually.

| Select/ Deselect |

If your machine has an automatic tool exchange, you can select and deselect a tool
here. Even if you don’t have an automatic tool selection you should use this button
to let Cenon know which z-offset and revolution it has to use for your adjustments.
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Conic Tools

Tip Angle (deg): (10 \] >

Max. Diameter (mm): |2 \J }

This part is only active for conic tools. Here you can set the tip angle and the maxi-
mum diameter of the tool. In this case you have to set the diameter at the tip of the
tool for the diameter field.

Thread Cutters

Pitch {mm) 1 \J }
Core Diameter (mm) 2 J }
Overshoot (mm) | 0 4 b

This part is only active for thread cutters. Here you can set the pitch, the core diam-
eter and the overshoot offset.

* Pitch is the pitch of the thread (the distance measured from one tooth to the
next).

* the core diameter (JC) is the core diameter of the tool.

* the overshoot offset (lo) is only used for a special kind of thread cutter and is
0 for normal tools.
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i

A
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il
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{1

4_| L@C _1_4_‘ LQC ‘.‘ oS
s} s} foct-

Drill Thread Cutter (DTC). The special cutter is able to cut the hole and the
thread at once. The overshoot (10) is the distance from the tip of the tool to the

For inside threads the cutter lowers to the surface of the material, from there
spiraling down to the bottom of the thread + overshoot. Finally, the tool is lifted

For outside threads the cutter approaches from the outside and has to be lifted
outside of the radius of the thread. Therefore you have to provide enough room

Combi Thread Cutter (Combi or DTC1). This type is used for inside threads
only. The tool diameter (@S) is the diameter of the inserted tool plus the depth
of the teeth! The core diameter (JC) is the diameter of the thread section
without teeth. The overshoot (lo) is the distance between the tip of the cutter

A Standard Thread Cutter.
cutting teeth.
out in the center of the thread.
for lifting the tool!
C
and the thread section.
@S | Tool Diameter
@C | Core Diameter
lo | Overshoot (Type B and C)
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Knifes
Distance before corner |-0.3 \| >
Distance behind corner |-0.3 \| >

This part is only active for knifes. Cenon allows over-cutting or under-cutting cor-
ners. This allows compensation of real-world limitations of knifes and materials.

:\. ) T )

Examples for negative (left image) and positive (right image) distances from corners.

3.4.5 Machine-Control

| Layer = Magazine Positions |

Here you can position the machine. You can also start and stop the output with this
panel.

Start Position

X: 0 4D
¥: 0 4D
[N 1 P 4

Mave Height: 1 b g
| Get || save || Set |
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In this field you can set the starting position.
Using the buttons, the machine moves in 0.1 mm steps. If you keep the Ctrl-key
pressed while moving the machine, the machine moves in 1.0 mm steps.

If you change the x or y positions, the z axis is always lifted to Move Height for
security reasons!

The setting of the x- and y-position you can also carry out with the cursor-keys on
the numeric part of the keyboard (as long as no text is edited).

Arrow up (8): moves the y-axis in positive direction
Arrow down (2): moves the y-axis in negative direction
Arrow right (6): moves the x-axis in positive direction
Arrow left (4): moves the x-axis in negative direction

Note: If you control the machine via the arrow keys, the machine may happen to
move a little longer than you pressed the key! Please take this into account.

]z |4 a4

Here you can set the position of the z-axis. The z position is the surface of your
material. The button for lowering the Z axis has a little magic in it: If you click it the
first time, the Z position is set. Only the next clicks will modify the Z position.

This setting you can also carry out with the cursor-keys (as long as no text is edited):

Arrow up (9) lift the z-axis

Arrow down (3) lower the z-axis

If you activate the Adjust Switch (lefthand of the Z field), you can adjust the Z-
position. This means that you can move X and Y to a position of your choice, and
there set the Z-position. If you turn off the switch, the X- and Y-axis return to their
initial positions.
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If you use a measurement sensor, you can start the measurement by clicking on the

down button.
Toal O

Material

Move Height

z— —z
[ |

Machine Table

Mave Height: 1 o

Here you can set the move height (or flight level). This is the distance the tool stays
above the surface when positioning. This height is not very critical. However you
must ensure that the tool moves height enough to get over all obstacles.

| Get || sae || Set |

With the button "Set Position" you can move the machine back to the start position,
for example after a Home drive or after finishing the output.

"Get Position" asks the CNC controller for it’s position. This is only available, if
your CNC controller supports this feature. The button enables you to set the starting
position more comfortable with a hardware control panel. When pressing the get
button, the machine position will be taken into Cenon as the start position. For Z this
is the surface position on your working piece. (Also take a look at the configuration
entry #GPA in Section 4.2)

- O

I

The two sliders allow the relative changing of the feed and spindle revolution during
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the output. The parameters are altered from about 20 to 200% of the values entered
for the tool.

The sliders are available only, if your CNC controller supports this feature. (Also see
the configuration entries #AVS and #ARV in Section 4.2).

| Adjustment |

| Home |

Here you can carry out an adjustment drive or a zero drive. An adjustment drive
justifies the machine and moves it back to the start position. A zero drive (Home)
moves the machine back to zero and remains there.

=) All

() Selection

Here you can choose whether all layers that are displayed with an open eye should
be given out (that means all the layers) or only the selected elements in the graphic
window (selection).

[ Stant |

This button starts the output. You get to the window that asks you to chuck in the
first tool when you don’t have an automatic tool change. During the operation the
button changes its look - it becomes a stop button. With this button you can end the
operation if you want. Please mind that the machine processes a few more vectors
before it stops. In case of emergency press the emergency-stop-button of the
machine!

=

| Spindel
[ | Suction
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Here you can control up to ten features of your machine, if your CAM controller
offers in/out ports. The switches can be defined in the device configuration file (see
section 4.2).

&

AN

During output, the progress can be displayed inside the graphics window (>= v4.1).
The position on the screen can be ahead of the machine. The exactness depends on
factors like the look-ahead or the use of commands to query the exact location of the
machine.

3.4.6 The Positioning Memory

| Layer | Magazine | Control BT

Here you can set the starting positions of the machine for different purposes.

| Butterfly Vg

With this pop-up-menu you can choose the starting position. With the last entry, new
position, you can create an new position. The current starting position is taken from
the Control-Panel as the value of the new position.
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| Remove |

Here you can delete the selected position-entry.

Mame: Butterfly

Here you can enter the name of the position-entry. We recommend to name the
position memory after the material that is worked there.

x[7 |4 D
v )
z[eo AW
Mave Height:z—_ﬁ. b

With these buttons you can set the starting position in the same way as in the Control-
Panel.
add Marker Positions | |

With this switch active, all the drill markings from the current document will be
added to the position list. Only markers with name are added to the list. When
positioning to a marker position, the move height is not set.

Return to parking position I:i

If you activate this switch, the machine returns to the parking position, after finishing
output.

| Move To Position |

The machine moves to the entered position and switches to the Control-Panel.

3.5 Layers

Additionally to normal layers, Cenon provides some special layers, which will be
described here. This special layers are for example the Clipping Layer (see sec-
tion 3.5.1) and the Levelling Layer (section 3.5.3)
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3.5.1 The Clipping-Layer

The clipping layer is a special layer used to clip objects on other layers for output.
It can be used for long signs which don’t fit on the machine table, and thus can’t be
processed at once. This process is also known as Panelling or Push-Through.

You can change a layer into a clipping layer by setting the layer type in the layer
details (see section 3.4.2).

Long signs can be divided in two groups:

1. Signs which can be produced in two parts, and are assembled later (example
1). Here you just can run two separate jobs

2. Signs where the working piece can’t be devided (e.g. a handwriting). In this
case the entire sign is divided into areas which are processed one after the other
(example 2).

Example 1

Example 2

Before you start, you should prepare a guide on one side of your machine. This
way you can move the working piece along the guide without worrying about the
positioning in this direction. By using markings you can even get highest precision
for moving the working piece.
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1. Place the material on the machine table.
2. Load the file with the complete sign (see example 2).

3. Prepare all necessary steps for cutting (tools, radius-correction, parameter etc.),
and calculate the output tracks

4. Now, the first part of the sign can be activated. To do this create a rectangle on

the Clipping-Layer. Use the Rectangle-Inspector to set the exact dimensions
of the rectangle.

M M M Rectangle

= BRIFIE

Lower Left

X0

b R

_Slze

W: 500

R 4 N
v

H: 1000
Angle
5 | dO=—0)
2 Corner Radius

0 4>

Lock [
7

In this example the first area includes approximately half of the sign. Be sure
to place the rectangle for clipping on the clipping layer. In the Rectangle-
Inspector the size and position are displayed. Position the crosshairs to the
same position as the rectangle.
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5. Now, move the machine to the lower left corner of the material and adjust the
tool. Then you can start the output of the first part.

6. Now you can define the second part of the sign: Therefore move the rectangle
on the Clipping-Layer to its new Y position using the Rectangle-Inspector. For
our example we get the following:



3.5. LAYERS 125

D M) O Rectangle

EHOl& |+

Lower Left

i

X0

4
¥: 1000 4
4
4

o |4 b

As you can see, we moved the rectangle from the position Y =0 to Y = 1000.

7. Now we move the crosshairs the same distance in the same direction:
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_E

At third we have to move the material the same distance in the same direction.
If you need highest precision use markings.

8. Now start the output.

9. Repeat the steps 6 to 8 until the complete sign is finished. Keep in mind, that
you have to move the clipping rectangle, the crosshairs, and the material. They
all have to be moved the same distance and in the same direction.

Note: The crosshairs are your zero point as well as the start point of your ma-
chine. So, the rectangle inspector displays the position relative to the
crosshairs, and on the other side, the Crosshairs-Inspector displays the
coordinates of the crosshairs measured from the zero point of your win-
dow.

3.5.2 The Fitting Layer

The Fitting Layer is used to place exactly two fitting marks. They are used, if you
have to process a working piece from both sides.
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To achieve this goal, the output can be mirrored by the axis between the two fitting
marks. Select the switch "Mirror’ in the Layer-Details (see section 3.4.1) to activate
the mirroring for a layer.

You create a Fitting-Layer by creating a normal layer (" New’ inside the Layer-Panel),
and afterwards changing the type of the layer to "Fitting bolts’ (Layer-Details panel).

The use fitting bolts is rather straight forward:

1. Create a fitting layer and place the two marks in a way that allows you to flip
your working piece by the axis between the two marks.

2. For all layers which shall be mirrored after filpping the working piece, activate
the switch *Mirror’ in the Layer-Details.

3. Start output by drilling the holes for the fitting bolts, so that you can fix your
working piece with two bolts.

4. Continue the usual output of the first side.

5. Now, flip your working piece, and process the mirrored layers.

You can find some examples using fitting bolts in the distribution of Cenon.

3.5.3 The Levelling Layer

The Levelling Layer appears if your CNC controller supports the surface measuring
of working pieces. This is the case for the vhf CNC 750.

In this case you can create a rectangle on this layer, which defines the area of mea-
surement.

In the Layer-Details (see section 3.4.1) of the Levelling layer, you can provide the
number of test points for the x- and y direction. The created rectangle will be mea-
sured using the given number of test points for each direction.
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If you want the surface of your working piece measured, be sure to display the lev-

elling layer, before starting the output. The Levelling layer is processed first, before
other layers are processed.

If you have measured the surface once, the surface usually remains measured until
you switch off the CNC controller (this can vary in different configurations).

3.6 Statistics Panel / Run-Time Panel (>= v4.1)

You can open the Run-Time Panel via the Tool menu: ”Tool >Run-Time Panel”, or
the keyboard shortcut: "Cmd Shift L".

®®® Run Time Information
RunTime Settings
= \ e
e Time Correction [%]: 100.00 auto | | ‘
%»_‘.3&\7 Time of Tool Change [s]: 0 Include closed Eyes |
T
Layer Name Moves [m] Drives [m] estimated Time Time left actual Time
All Layers 2.33 1.79 00:07:53 00:04:15 00:03:38
Contour 0.14 0.11 00:00:18 00:00:18 00:00:00
Soldering 1.28 0.87 00:04:03 00:03:48 00:00:15
BlowUp 0.71 0.67 00:02:39 00:00:04 00:02:35
RubOut 0.20 0.15 00:00:53 00:00:04 00:00:49

The image shows a Run-Time Panel during output. The layer "Contour” is beeing
processed. Times in red lay ahead, times in green are completed.

Bild zeigt eine Laufzeit-Berechnung mitten in der Ausgabe: Die Lage "Kontur" wird
aktuell bearbeitet, in Rot wird die Restzeit der auszugebenden Lagen angezeigt, Griin
wird die tatsdchliche Ausgabezeit (bis zum aktuellen Stand bzw. der letzten voll-
standigen Ausgabe) angezeigt.
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Pre-Conditions: To get useful results, the following has to be provided:

* in the CAM Preferences, you have to choose the correct device file(see sec-
tion 3.1.1).

* you have to assign tools with all parameters correctly set (see section 3.4.4).

* the tools need correct speeds (XY and Z).
Possible changes of the speed during the output are not included in the calcu-
lations and will .

* you have to set the move height inside the CAM-Panel (see section 3.4.5).

* the output has to be calculated (for example by displaying the output from the
Layer-Panel).

In short, the job needs to be fully prepared for output to the machine.

Settings:

Time Correction [%] the adjustment in % (Default = 100%). This affects the
total time of the output job.
Meaningful values can be between 50 - 200 %.

Time of Tool Exchange [s] if a time is provided, it is used for the tool exchange. For
certain CNC controllers (vhf CNC 950 series), the tool
exchange times can be calculated.

auto the time-correction will be calculated automatically after
a complete output. This only makes sense, once the job
will not be modified any more.

Include closed Eyes this will include layers, which are not displayed into the
calculation
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Table:

Layer Name

Moves [m]
Drives [m]
Estimated Time

Time left

Actual Time

This column lists the layer names. Only included lay-
ers are listed (see settings). The first line ”All Layers”
displays the sum of all layers.

This column displays the length of positioning moves.
This column displays the length of the output paths.
The estimated time of output.

The time left to finish the output. On Start this is identi-
cal to the estimated time. An the end of the output, this
is 0.

The actual time needed for the output. On Start this is 0.

Colors (columns ’Time left”” and ”’Actual Time”):

Red

Green
Gray

Black

Scheduled for output (not processed yet), or currently
being processed

during output or output completed
previously obtained (and saved) values

calculated values / estimates, or layers which are cur-
rently not machined

If the output to the machine is halted, or during an Alert-Box from Cenon, the time
will be halted and the pause is not counted (in the column “actual time”). This is also
true for manual tool exchange.
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3.7 Barcode Import

This special feature allows the import of files via a code, which is entered into the
following panel. The code can also be entered using a bar code reader. Application
of this function is in large series production. The required lists of codes can be
generated by a spread sheet or a database program.

If the feature is activated, the panel can be reached through the menu "Document >
Open Barcode...".

New ... EAy
Open ... #£0
Open Barcode ...
Import ... ™ ™ © Open Barcode
Impart ASCII ... AR :
Revert To Saved ... 36U % Open with Code
Save 35 g@}
save As ... oES 0
ID: 123456
Print ... 5P

Save Output ... &

To use this function, a configuration file must be placed into the library folder (See
Section 5.2) of the user. The configuration file describes the format of the list of
codes and filenames. The filename of the configuration must be "barcode.plist".

Example of a "barcode.plist":
/* This file configures the loading of files via bar codes entered
* into the Barcode Panel of Cenon.

A1l paths are relative to "Library/Cenon/CAM" or absolute "/...".

If the name (2nd entry) from the list file (listPath) is relative,
an optional folder name (3rd entry) may be added.

examples of formats (’listForm’):

" 57975;00006427 .dwg;00006" -> "Y5s;%12s;%5s"

" 57975;00006427 .dwg;00006" -> "%[0-971;%[~;1;%[0-91"
"123456 fileName folder" -> "%s hs %hs"

* K K X ¥ X ¥ ¥ ¥ *

*
~
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{
enabled = 1; // 1 = enabled, 0 = off
listPath = "zeichnvz.txt"; // HOME/Library/Cenon/CAM
//1listForm = "%s %s %s"; // identifier, file name, [folder name]
listForm = "% [~;1;%[~;]1;%s"; // identifier, file name, [folder name]
filePath = ""; // HOME/Library/Cenon/CAM
setMarker = 1; // 1 = set marker at UR position
layerName = "Bounds"; // name of layer for marker

}

Description of the Entries:

enabled

listPath

listForm

filePath

setMarker

is this entry = 1, the function is activated and the Menu item appears.

Here, the name and path of a list, containing the mapping of codes and
file names, is defined. If only a name is given, the library path is as-
sumed.

This entry defines the format of the list. Each line must be in the order
code, file name, and an optional folder name.

%os is a wildcard for any characters
%[";] is a wildcard for any character up to a semicolon
%3s is a wildcard for a string of exactly 5 characters

%|[0-9] is a wildcard for the characters O - 9

This entry defines the path of the imported files. If empty, the library
path is used.

If this entry is = 1, a marker is placed at the position of the bounding
rectangle of the imported graphics. This marking will get a name and
may be used inside the position memory (See Section 3.4.6). The marker
is playced on its own layer.

layerName The name of the layer, which will be added for the marker.
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The Syntax of the configuration file:

The syntax of the configuration is the same as used for most other configuration files
in Cenon. Each entry is a relation of the form KEY = VALUE;
An entry must be terminated with a semicolon.

{...} encloses the contents of the entire file
[*..%] encloses a comment

/1 starts a comment up to the end of line
KEY = VALUE; an entry

The mapping file:

The list for the above configuration may look like this:

" 57975;fi1e001.dxf ;folder1"
" 57976;£f11e002.dxf ;folder2"
" 57977 ;£i1e003.dxf ;folder2"

3.8 Embedded CNC Commands

Text in a Textbox starting with #COMMAND_BEG#" or "#COMMAND_END#"
will be interpreted as direct CNC command. The rest of the string will be transfered
as it is to the CNC controller / machine.

COMMAND_BEG will be send to the machine at the beginning of the layer, but
after the tool has been selected (if applicable).

COMMAND_END is send to the machine at the end of the layer. See example:
LIBRARY/Cenon/CAM/Jobs/EmbeddedCNCExample.cenon
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%coMMAND BEGH# T %coMMAND_END#”
0857,1:056,0: GA,,20000;
D1000;GA, 50000; = . .
ID1000;088,1;

- - - - - -




Chapter 4

Device Configuration

4.1 General Information

The configuration files of Cenon are ASCII files containing all the information needed
for the definition of devices and import formats.

This section will describe how to configure Cenon for the different "dialects" of
Gerber, HPGL as well as for your own XYZ-units and controller. Although Cenon
comes with a number of predefines configuration files (*.dev), there is a chance that
the commands of one or the other program is not understood properly or that there
is no 100% matching configuration file available for your controller or device. Un-
fortunately, there are slight differences in the command set of the different programs
and controllers.

4.1.1 Creating your own configuration files

In case you do not find a suitable configuration file for you purpose in one of the
device directories (HPGL, DXF, xyz etc.), you can alter an existing file.

e Start a text editor.
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Load an already existing configuration file (extension: *.dev). Only load files
from the appropriate directory and save them in the same directory after mod-
ification. This is very important, because Cenon uses the directory name for
accessing the right file format. The setup directory names, for these reasons,
should not be changed. Therefore, a Gerber configuration file should only be
placed in the directory Gerber, etc.

To avoid duplication of work you should load a configuration file which matches
the command set of your computer. You can change the configuration file to
your needs using the information provided in the output device manual.

After changing all necessary entries you have to save the file (to the same
directory under a new name) and quit the text editor.

Load from within Cenon the newly created file (Menu: Info > Preferences) and
you are ready to start.

4.1.2 Important Notes

The comments before the number sign (here: controller) are not important for
the program (comment here: device name). These can be changed to your
needs or even deleted. Cenon is recognizing only the characters from the num-
ber sign to the end of the line (here: "CNC750"). Example:

controller #CNC “‘CNC750’’

The entries are not permitted to exceed more than one line.

The order of the entries is not important, unless there are several entries with
the same #-code. You can also delete an entry if it is not needed.

Within a command line you can add after a backslash () certain sequences to
the code. You could for example, write in a new line each single command in
the output file:
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\n Neue Zeile (Zeilenvorschub)

\e Escape-Sequenz

\r Carriage Return (Wagenriicklauf)
\" Anfiihrungszeichen

* If you have to leave space for variable parameters, which will be provided by
Cenon. This is done with a percent sign (%) followed by a letter:

Yot will accept a floating value (with decimal values entries). The
output format can be regulated with these entries. Examples:
%.0f  ->1
%.2f ->1.00
%?2.2f ->01.00
%2t ->01

%d is describing decimal integers

Jox is describing hexadecimal values

%ld is describing decimal long integers

Yoe is describing numbers with exponents

* Transmitted commands are always in quoted and also contain the appropriate
variable (e.g. pen selection for a HPGL-Plotter:

select pen #PEN "SPyd;"

e Parameter providing information to Cenon (e.g. number of pens for HPGL-
plotter or the size of the working area) are not quoted:

number of pens #NPN 8

* If several values are passed on to the program in one command line, these
values have to be separated by at least one space (e.g. maximum working area
of a unit):

X Y Z-maximum range (mm) #SIZ 380 235 63
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4.2 CNC Devices (CNC controller)

4.2.1 General Information

Almost all CNC-controllers are different in their command set and almost each single
output device has different scaling or resolution. For Cenon to address your config-
uration properly, you should check the configuration file before you first use your
output device. As mentioned earlier, you can find this configuration file in the folder
Devices/xyz. The files have the extension *.dev. You can edit these files, make your
changes accordingly and save the file. The name of the *.dev file will then appear in
the appropriate pop up in the Cenon Preferences-Panel.

In the following section, we will explain how to change certain parameters to suit
your specific device. These parameters are needed to drive the CNC-controller. If
you do not know the parameters for your device, please refer to the device manual
or determine the correct values by carefully measuring and testing. Many of these
command set are similar to HPGL command sets.

4.2.2 Commands in the configuration file

description #DES

Enter in this line the name of your device or of the controller used. This line has only
explanatory value.

controller #CNC

Here you have to enter which controller principle your device is using. You have the
following choices:

"HPGL" HPGL compatible devices

"DIN" DIN 66025 compatible devices, G-Codes
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"CNC450" using extensions for vhf controller CNC 450
"CNC750" using extensions for vhf controller CNC 750
"CNC550"
"CNC950"
"CNC1050" using extensions of the vhf CNC 300, 550, 551, 580, 800, 950,
980, 1050 controller series
"ISEL" support for the ISEL command set
"MCM" support for the MCM command set
spindle lift time (ms) #TIM

Time in milliseconds needed to lower or lift from the working part. This is only
necessary for devices with a switching axis.

origin (O=lower/left 1=upper/left) #0RI

You can enter here if the origin of the output device is located in the upper left corner
(for XYZ devices) or in the lower left corner (for plotters). If for any reason this
entry is missing, it is automatically assumed that the origin should be located in the
upper left corner.

Z origin (0O=down zero, 1=up zero) #0RZ O
Here, the Z coordinate system can be inverted.

look ahead #AHE

Number of commands (not characters) which are send to the device before checking
the return values.
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terminator (for removal of return values) #TRM

Separator between commands. It is used to keep track of the number of commands
send to the device.

non

Example: ";
comments (’*’ = wildcard) #REM

This entry may be used to remove remarks from large initialization sequences (#INI,
#INI1). The entry must start with the starting character(s) of the comment, followed
by an asterisk (*) and the terminating character of the comment, usually a line feed
(\n).

Example for CNC 550: "/*\n"

debug level (0=off) #BUG

To test the connection and processing of a new controller, you can activate the debug
output. If you set a value other than 0, the machine initialization, outgoing commands
and return values are logged to the console window.

baud rate #BAU

If your controller is connected to a serial port or USB port, you have to enter a baud
rate. This rate indicates the speed of data transfer between computer and output
device. The baud rate has to be set to the same rate of the controller to be able to
communicate with the device.

The following baud rates are supported by Cenon (if the serial port supports the baud
rate):

1200, 2400, 4800, 9600, 19200, 38400, 57600, 76800, 115200, 230400, 460800
baud

device #DEV
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The Unix device used for output. Example: "/dev/ttySO"
parameter (0=8N1, 1=7E1) #PAR

Set the transmitting values for the serial port here. Enter a 0 for 8N1 (8 data bits, no
parity, 1 stop bit) or a 1 for 7E1 (7 data bits, even parity, 1 stop bit).

handshake (2 = XON/XOFF) #HSK
This can turn on a software handshake.
X Y Z-maximum range [mm] #SIZ

You should enter here the unit of measurement for your controller in points per inch
for all three axes. If you use a switching axis for z, insert the same value than for x
and y.

X Y Z-resolution controller [points/inch] #RES

This entry holds the resolution of your CNC controller for all three axis in points per
inch. If you use a switching axis for Z, set the value for Z equal to X or Y.

X Y Z-resolution of mechanics [steps/mm] #SCL

These values describe the mechanical resolution of your device for all three axes. It
indicates how many steps are necessary to cover one millimeter. Calculated example
for the device CAM 100:

[steps/rotation] / [pitch of spindle]

= [steps/rot] / [mm/rot] = [steps/mm)]
=400/5=280

this entry would look like this: #SCL 80 80 80
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Flatness #FLT

Enter here a precision factor with which bezier curves (and arcs) will be divided for
the output device. If this value is large the curve appears very coarse. In case a value
is missing a default value is assumed. If this entry is missing, the default(0.15) is
used.

Maximum length of line [mm] #MLN

Some CNC controllers don’t provide a command to stop the output process. If you
would stop the output, the machine would continue to draw the last command com-
pletely before stopping. If this was a long line you have to wait quite a time before
the machine finally stops. To set the maximum length of line to a reasonable value
(eg. 5 mm) will allow you to stop the output immediately. Additionally, some CNC
controllers move smoother with shorter line segments.

X Y Z Positioning Offset (cartesian) [mm] #POF

If you have attached a surface sensor etc. to your machine for more exact interactive
positioning, you can enter the distance of the sensor to the tool. If you adjust the
position using the Control-Panel of Cenon, the offset is added to the real position.
For normal applications this offset is zero for all axes.

XY Camera Offset (cartesian) [mm] #COF

This offset is used solely for a mounted camera, to allow a camera being mounted
together with a surface sensor. The offset is the distance of the camera relative to the
tool. The tool being the origin.

Example: #COF 60.0 5.0

To get the offset, you can use the following procedure:

1. In the Control-Panel, move the tool to an integer position (ex: 100/100). At
this position, create a marking dot (ex hole).



4.2. CNC DEVICES (CNC CONTROLLER)

2. Move the dot into the center of the camera image.
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3. Read the X and Y position from the Control-Panel (ex: X =129.93,Y =78.95)

4. The offset calculates now as: X-Offset = 100 - X, Y-Offset = 100 - Y
For our example: X-Offset = -29.93, Y-Offset = 21.05

XY-minimum speed for draw [steps/s] #XMI

This entry describes the minimum working speed in steps per second the device can
use to complete the job (engraving or routing mode). The working speed entered
here and the following entries describe the minima and maxima for the speed. The
actual used speed can be entered from the depot window where you have access to

the different tools available or configure new tools.

XY-maximum speed for draw [steps/s] #XMA
Maximum working speed in steps per second.

Z-minimum speed for draw [steps/s] #ZMI
Minimum speed for lowering the tool onto the working part.

Z-maximum speed for draw [steps/s] #ZMA

Z-maximum speed for the z-axis while lowering the tool into the working part.

XY-speed for move [steps/s] #XPV
Speed for positioning the tool on the move height (flight level).

Z-speed for move [steps/s] #ZPV
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Speed to adjust the positioning of the tool in z-direction above the working part.

initialize #INI
initialize 1 #IN1

To configure your output device to your needs, all data to initialize the unit (e.g. steps
per rotation, etc.) have to be available first, even before any data of the actual task
will be passed on. You can insert any necessary command to initialize your device.
IN1 is send directly after INI, so you can split your initialization into two parts.

adjustment drive #REF

Code to start the adjustment drive (referencing). Example: #REF "!N;RF;"

adjustment drive time [s] #RFT (>= v4.1)
Number of seconds to do reference the machine. Example: #RFT 60

switchl on off title safeFlag autoFlag #SW1
switch2 on off title safeFlag autoFlag #SW2
switch3 on off title safeFlag autoFlag #SW3
switch4 on off title safeFlag autoFlag #SW4

Entries for the actions of up to ten switches in the switch-block of the CAM Control-
Panel (see Chapter 3.4.5).

Example: #SW2 "0S4,1;" "0S4,0;" "Title" 1 0

The switch entries expect the following parameters:

1. Command for switching ON

2. Command for switching OFF
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3. Title of the switch, or "" to leave the default values.

4. Flag: 1 = switch can be switched during output, 0 = switch is inactive during
output.

5. Flag (optional, >= v4.1):

1 = The CAM Control-Panel displays a row of switches with the Title ”A” =
Automatic.

The corresponding switch can be set before or during output. If an auto-switch
is set, the corresponding OFF-command is send before a tool change and Stop
(including Alert Panel). The ON-Command is send after a tool exchange and
”Continue”.

0 = inactive (Default). The switch in the auto column is not operational.

return value for ok #RET

Any action performed flawless by the CNC controller is prompted by sending a reply
to Cenon. This reply can be entered here as a decimal value for most controllers.
The vhf CNC controllers of the 550, 950, 1050 series, return several characters as
reply. In this case two strings are expected here: first the entire reply string, second
the initials of optional error codes.

If you don’t enter a value here, no return values are checked.

Example for a return value of ’0’: #RET 48

Example for the CNC 550: #RET "0;" "E"

separate thread for return values (1=Yes) #THR

If you activate an extra thread, then the return values during output are collected
asynchronous by a separate thread. This improves the output performance.

This option can only be used with controllers, which support the wait command
(#WALI) like the CNC550 and CNC950. The option Look Ahead (#AHE) is ignored,
if you activate the thread.

wait until all data is processed #WAT
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The command is send after sending all data to the controller to wait until the con-
troller has finished operation. Cenon waits until the controller sends a ’!” to signal
that all data has been processed.

Example: "!H1;"

delay #DEL

Delay command to wait until the spindle achieved its revolution. The time value
#TIM can be used here by providing a variable (%d).
Example: "D%d;"

set speed draw (v) #VDR
set speed move (V) #VMV

Commands to set the working speed (speed inside the working part) and the position-
ing speed (move). The commands can be different for draw and move. If #VMV is
missing the entry of #VDR is used. If you are using special move commands (#G1D,
#G2D, #G3D), no move speed is needed.

Example: "VS%.0f;"

move absolute (x,y,z) #G3D

Command to move in X, y, and z direction. No speed is set, before issuing this
command. If this command is missing, Cenon will interpolate it with #MOV and
#MVZ.

Example: "GA%.0f,%.0f,%.0f;"

move absolute (x,y) #G2D

Command to move in x and y direction. No speed is set before issuing this command.
If the command is missing, the corresponding draw/move command is used (#MOV).
Example: "GA%0.1,%0.f;"
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move absolute (z) #G1D

Command to move in the z-direction. No speed is set before issuing this command.
If the command is missing, the corresponding draw/move command is used (#MVZ).
Example: "GA,,%0.f;"

draw/move absolute (x,y,z) #M3D

Command to move in X, y, and z direction. If this command is missing, Cenon
will interpolate it with #MOV and #MVZ. The speed will be set before issuing this
command.

Example: #M3D "A3%.0f,%.0f,%.0f;"

draw/move absolute (x,y) #MOV

Command to move in x and y direction. The speed will be set before issuing this
command.
Example: #MOV "PA%0.f,%0.f;"

draw/move absolute (z) #MVZ

Command to move in the z-direction. The speed will be set before issuing this com-
mand.
Example: #MVZ "ZA%0.1;"

arc (x-center,y-center,angle) #ARC

Code to draw a circle segment (arc) in the HPGL style. If all arc commands are miss-
ing Cenon will interpolate arcs. The flatness entry (#FLT) is also used to interpolate
arcs.

Example: #ARC "AA%0.f,%0.1,%0.f;"
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arc cw X Y A B (ctr X, Y, ang beg, end) #G02
arc ccw X Y A B (ctr X, Y, ang beg, end) #GO3
arc cw R A B (radius R, ang beg, end) #G02
arc ccw R A B (radius R, ang beg, end) #GO03
arc cw X YR (end X, Y, radius R) #G02
arc ccw X Y R (end X, Y, radius R) #GO03
arc cw X Y I J (end X, Y, offset x, y) #G02
arc ccw X Y I J (end X, Y, offset x, y) #GO03

Code to draw an arc in different G-Code / NC derivates. G-Codes (also DIN) needs
two arc commands, one for clockwise and one for counter clockwise arcs. Addition-
ally, there are several alternatives of the commands with different sets of parameters.
Cenon determines the derivative from the number of parameters and the use of the
tags” X, Y, A,B, L, J.

Example: #G02 "G2 X%.3f Y %.3f 1%.3f J%.3f\n"

curve (x2,y2,x3,y3,x4,y4) #CRV
curve (x2,y2,z2,x3,y3,23,x4,y4,z4) #CV3

Code to draw a 2 or 3 dimensional curve. If this command is missing, Cenon will
interpolate the curves. In this case the value given for the flatness (#FLT) is used.

helix (x-center, y-center, angle, z) #HEL

Code to draw a helix. If this command is missing, Cenon will interpolate the helix
using arcs or lines.

tool up #TUP
tool down #TDN

If you are using a switch-axis with lift magnet instead of a freely positionable z-axis,
you can enter the code for lifting and lowering here.
Example: #TUP "PU;"
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select tool (n) #TOL

If you have an automatic tool selection, insert the command to change the tool here.
If this command is missing, Cenon will ask you to change the tool.
Example: #TOL "SP%d,1;"

safe manual tool change (default = 1) #TOS (>= v4.1)

Flag to turn off safe manual tool exchange (#TOS)

During a manual tool exchange, the Z axis will be lifted completely before every
start and will always ask to insert a tool, even if the tool is selected already. This safe
behaviour can make work slower.

If you set #TOS = 0, Cenon will not ask for a tool, if the tool is selected already.
Warning: make sure, that the same tool magazine is used for all output jobs !
Warning: make sure, that you didn’t change the tool without Cenon being informed.

tool start index (default = 1) #TSI

This entry sets the start index of the tool exchange (#TOL).

set spindle (rev/min) #REV
spindle off #RVO
spindle range (min, max) #RVR
spindle on at origin (default = 0) #RVU (o= v4.1)

If you have a spindle which can be automatic driven, insert the commands here. You
have to provide a command to switch on the spindle, and set the revolution (#REV).
The second command switches off the spindle (#RV0). The third entry (#RVR) tells
Cenon the range of revolution the spindle can achieve. If the commands are missing,
Cenon will ask you to switch on the spindle. The optional fourth entry decides,
weather the spindle is turned on at the Z origin (1) or at flight level (0 = Default).
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Example:

#REV "RVSYd;"
#RVO "RVSO;"
#RVR 5000 60000
#RVU 1

get position #GPA

This entry allows reading the machine position into Cenon. If the entry is available,
the corresponding button inside the Control-Panel of Cenon is activated. You can
make use of this feature to set the starting position directly at the machine with a
hardware control panel.

The reply to this command from the controller is expected in the form "PA=x,y,z,...".
The Z position is used as the surface position.

Example for CNC950:

#GPA "7PA;" "PA="

get serial number #GPA

This entry queries the serial number form the CNC controller. The command needs
two or three parameters, depending on the return value.

1. Command to query the serial number

2. Prefix: characters before the serial number

3. Suffix: characters following the serial number (if not the terminator)

Example:

Serial Number (CNC950-Series) #GSN "7V;" "SN " " "

Automatic Tool Change (>= v4.1)

This section describes setting up an automatic tool change, which is coordinated by
Cenon. Additionally, it is still possible to let the CNC-Controller / Plotter coordinate
the tool change.
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select tool (n) #TOL

If you have an automatic tool selection, insert the command to change the tool here.
If this command is missing, Cenon will ask you to change the tool.
Example: "#TOL SP%d,1;"

#TO1 "Get Tool" "Remove Tool"
#T02 "Get Tool" "Remove Tool"

The content of your #T01-n commands, depends on your CNC-Controller. Please
contact your machine manufacturer for documentation. You have to configure the
moves to the tool changer, the Opening/Closing of the chuck, and the moves away
from the tool changer. Example:

#TO01 "TKO;GV,,0;RVS0;082,0;GV50000,10000;083,1;!D1000;GV,,3000;VS20000;PV,,6000;083,0;!D2000;PV,,4000;GV,,0;"
"TKO;GV,,0;RVS0;082,0;GV50000,10000;GV,,3000;VS20000;PV,,6000;083,1; !D2000;GV,,0; !D500;"
#T02 "TKO;GV,,0;RVS0;082,0;GV75000,10000;083,1;!D1000;GV,,3000;VS20000;PV,,6000;083,0;!D2000;PV,,4000;GV,,0;"
"TKO;GV,,0;RVS0;082,0;GV75000,10000;GV,,3000;VS20000;PV,,6000;083,1; !D2000;GV,,0; !D500;"
#T03 "TKO;GV,,0;RVS0;082,0;GV100000,10000;083,1;!D1000;GV,,3000;VS20000;PV,,6000;083,0; !D2000;PV,,4000;GV,,0;"
"TKO;GV,,0;RVS0;082,0;GV100000,10000;GV,,3000;VS20000;PV,,6000;083,1; !D2000;GV,,0; !D500;"

Tool Gauging

#TMZ "Gauging" "Return Format"

The #TMZ command has to be configured, if the #T01-X commands doesn’t contain
tool gauging by the CNC-Controller.

The tool gauging can also be used with a manual tool exchange (TOL inactive). You
can find the commands in the CNC manual provided by your machine manufacturer.

The tool gauging needs a physical switch connected to an input of the CNC electron-
ics.

The gauging commands have to include the moves to the gauging switch, the gaug-
ing itself, and the moves away from the gauging switch.

The Return Format has to decribe the entire reply from the CNC Controller, using a
wildcard for the variable value holding the length of the tool. (%f = decimal, %d =
integer). Example:

#TMZ "GV17550,30;GV,,3000;ME3,1,5,1,5000;GV,,0;" "ME3=)f"
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Measurement
measure surface position #SFM
get surface position (CNC750) #SFG
sensor height [mm] #SFH

These commands may be used to determine a tool offset measured relative to the
surface of the working piece. This is always used for automatic tool change. The
measurement lowers the Z axis until a switch or contact is triggered. The position
can either be returned directly (ex. CNC950) or queried in a separate command (ex.
CNC950). Also see section 3.4.5. The height of the sensor itself may be provided. It
will be simply added to the measured distance. Example:

#SFM "WMZ;"
#SFG "7?V40; 'HO;"
#SFH 10.0

Surface Leveling

Leveling CNC750 (x, y, nx, ny) #LEV
Leveling Default (nx, ny, deltaX, deltaY) #LEV
Leveling, keep tool (1 = keep tool) #LEVT 1

If your controller provides a command to measure the surface of a given area, you
can insert it here. Cenon supports two variants of this command, one for the CNC750
controller and a default one. Examples:

Leveling CNC750 #LEV "SH3, %f, %f, %d, %d;"

Leveling CNC950 #LEV "SH2, %d, %d, %f, %f;"

Asynchronous Commands

halt #HLT
continue #CNT
break #BRK
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If your controller provides priority commands to stop, continue and break execution,
you can insert them here. Examples:

#HLT "!S;"
#CNT "!1C;"
#BRK "!B;"

After canceling the output the synchronisation between Cenon and the CNC con-
troller is lost. To restore synchronisation Cenon proceeds as follows: If a synchroni-
sation command (entry #WALI) is available, it will be send and waited for the return

sign ’!’. Without a synchronisation command Cenon clears the input stream for 5
seconds.

alter speed (0 - 200%) #AVS

alter revolution (0 - 200%) #ARV

These entries allow changing the speed and revolution during output. If the entries
are available to Cenon, the sliders inside the Control-Panel of Cenon are activated
during output. Example for the CNC950 series:

#AVS "QVAYd;"

#ARV "ORVAYd;"

Tangential knife

The entries #TAN, #TAM and #MVT are used to drive a tangential knife. Cenon
controls the rotation of the knife in this case.

/*
* tangential knife
*/
range (mm), res mechanic (points/inch) #TAN 720 352.778
range = 2 * 360 deg
res = 5000 pts/U / 360 deg * 25.4
max angle (deg), max vector (mm) #TAM 20.0 1.0
move + rotate knife (x, y, t) #MVT "PAY.0f,%.0f,,%.0f;"
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#TAN

#TAM

#MVT

Attention:

CHAPTER 4. DEVICE CONFIGURATION

provides the range and resolution of the T-axis. The values can be cal-
culated by the given formula. The example values are the defaults. The
values in the example are the defaults.

provides the maximum angle to rotate the knife within the material (in
degree of arc), and the maximum vector length to rotate the knife while
moving the vector (in mm). The values in the example are the defaults.
For angles larger the maximum angle, the Z axis is lifted to rotate the
knife.

For segments longer than the maximum vector length, the knife is ro-
tated at the end of the vector. This allows a smooth continuous rotation
for curves and arcs (small vectors), while long straight lines are cutted
without rotating the knife.

provides the command to move the T axis.

The values indicated in parenthesis () in the comment part on the left, show the
parameters your command has to provide, and are later inserted by Cenon. For each
parameter listed, the code has to have an identification of the number type (e.g. %f
for a floating value; see section 4.1.2 for details).
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Appendix

5.1 What you should know about tools

5.1.1 Reasons for more cutting edges ...

The cutting edge is the working part of the tool. The more cutting edges a tool has,
the more cutting edges share the tool erosion, thus the life of the tool is longer.

* A cutter which has two or more cutting edges runs more true than a milling
cutter with just one cutting edge.

* Due to the larger cross section of the multiple teeth cutter, more heat is trans-
ported to the collet chuck. This is especially helpful if there is no other way of
cooling.

* The more cutting edges there are, the smaller the chips become, so you will get
smoother surfaces. A double tooth cutter is suitable especially for working on
very hard synthetic material and harder aluminum types. We recommend triple
tooth cutters especially for very hard non-iron metals and iron workpieces.
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5.1.2 Reasons for few cutting edges...

The main problem that may occur during the milling process is the possibility that
chips may choke the tool. If a milling cutter is finally choked, it cannot carry out
chips any more and the feeding force of the spindle will break it. This happens -
depending on the material - in most cases long before the cutting edges are worn
out. So the main question is where to put the chips. "To the top or to the back"
is usually the answer (except left-hand twist cutters). However, a certain space is
necessary to move the chips along the "body" of the cutter. A comparison of the
cross section of different types shows clearly that the single tooth cutter offers the
largest open space (size of the grove for chips) and that this space is reduced with
increasing number of cutting edges. It is easier for a milling cutter with few cutting
edges to dip into the material. For working on material which is used mainly for sign
making like synthetic material, wood and non-iron metals, the single tooth cutter has
certain advantages. The danger that the cutting edges may erode is not as serious as
the problem that the cutter may get choked.

5.1.3 Cross Section:

« £
L

A Single tooth cutter offers a wide open space (left image).
Three cutting edges need much more space (right image).
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5.1.4 Working Parameters
General rules:

1. The higher you set the cutting speed (vc = pi * @S * n), the smoother the
surface will be. At the same time the erosion of the tool increases.

2. Recommended cutting speeds vc for carbide milling cutters:

e Aluminium: 100 - 300 m/min;

* other non-iron material (brass, bronze, copper, zinc): 100 - 200 m/min;
e stainless steel (VA): 80 - 120 m/min;

e thermoplastic: 50 - 150 m/min;

* duroplastic with filling material: 100 - 150 m/min;

carbon fiber compound material: 150 - 300 m/min.

3. Recommended feed fz per cutting edge and revolution for carbide milling cut-
ters:

e Aluminium and other non-iron metals:
@S 2 - 4 mm: 0.04 mm/U
@S 5 - 8 mm: 0.05 mm/U
@S 9 - 12 mm: 0.10 mm/U

* Thermoplastic:
@S 2 - 4 mm: 0.05 mm/U
@S 5 - 8 mm: 0.06 mm/U
@S 9 - 12 mm: 0.07 mm/U

* Duroplastic, GFK:
@S 2 - 4 mm: 0.04 mm/U
@S 5 - 8 mm: 0.08 mm/U
@S 9 - 12 mm: 0.10 mm/U
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4. Formulas:
revolution n: n [rev/min] = (vc [m/min] *1000) / (3.14 * @S [mm)].
feed f: f [mm/min] =n * fz * z

Example:

You want to mill aluminum with a double tooth cutter @S = 3 mm (given above:
max. vc = 200 m/min).

max. revolution n:

n (200 * 1000) / (3.14 * 3) = 200.000 / 9.42 = 21230 rev/min

feed f:

21230 * 0.04 * 2 = 1698 mm/min

Hh
Il

5.1.5 Geometry and Dimensions
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Shape A:  diminished cutting diameter @S < @Z.
Shape B:  cutting diameter equals staff diameter @S = @Z

Shape C:  extended cutting diameter @S > @Z (only for drills)

Right-hand Left-hand

twist twist
& &

A L R e

'S4 4

Right-hand twist cutters:

The chips are transported to the top. The milling cutter tendends to lift up the work-
piece (corkscrew effect).

Left-hand twist cutters (custom shape):

The chips are pushed down, resp. moved to the back, i. e. to the already milled chan-

nel. The milling cutter pushes the workpiece down on the table (reversed corkscrew
effect).
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5.1.6 More Information on Tools

Online Tool Parameters ~ Online service to calculate the parameters for your tool
and material. Please visit our web site (http://www.Cenon.com)
to find a link to the tool.

5.2 Files and directories

5.2.1 Cenon program

The program file of Cenon is located in the application directory of your computer
system:

Apple: /Applications/Cenon.app
GNUstep: /usr/GNUstep/Local/Applications/Cenon.app

OpenStep: /LocalApps/Cenon.app

5.2.2 Library

In the Library path of Cenon you can find examples, projects and all the things which
are intended to be customized (configurations, data files, etc.). Cenon has a global
Library path shared between al users, which is not writable to a user, and a local
Library path inside the home directory (here HOME) of the user:

Apple: /Library/Application Support/Cenon
HOME/Library/Cenon

GNUstep: /usr/GNUstep/Local/Library/Cenon
HOME/GNUstep/Library/Cenon
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OpenStep: /LocalLibrary/Cenon
HOME/Library/Cenon

Files can appear in both Library paths (the global library path and the home library
path). In this case the file in the home library path has priority. This allows a user to
modify a configuration file without changing the installation of Cenon.

In the following we describe the most important files and directories. All located in
the HOME-Library of Cenon:

| File / Folder | Description
Projects Your Cenon projects and examples
Examples Some examples of import formats
Devices/din/*.dev Configuration files for the drill data import

Devices/gerber/*.dev | Configuration files for the Gerber import
Devices/hpgl/*.dev Configuration files for the HPGL import

Devices/xyz/*.dev The device configuration files

CAM Folder for special configurations
CAM/Jobs Your CAM projects and example projects
CAM/positions ASCII file holding the position memory
CAM/magazine ASCII file holding the tool magazine

Cenon provides two folders for projects (Projects and CAM-Jobs). There is no tech-
nical differences between the file format.

5.2.3 Lock Tool-Magazine (>= v4.1)

You can protect a tool magazine from certain modifications, like creating and remov-
ing tools. In a locked magazine, only the parameters of already existing tools can be
modified.

A locked magazine cannot be deleted, no tools in the magazine can be created or
removed, and you can’t rename tools, or change their order.

A magazine can’t be locked from within Cenon. To lock a magazine, you have to
edit the magazine file with a text editor as follows:
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(
MagazineName,
lock,
{

cuttingSpeed = 3.00;
diameter = 1.00;

The "lock" entry has to be added to the file "magazine" inside the User-Library. The
lock entry has to be added to a new line, right behind the name of the magazine.

"/USER/Library/Application Support/Cenon/CAM/ magazine"

5.3 Error and Warning Messages

* Select two objects for joining!

You have to select two objects to be able to join them and create a path object.

* Can’t create backup file. File not saved!
Check if you have write permission to the directory and the Cenon file you
tried to write.

* Could not open file FILENAME.

Check the read permissions on the file FILENAME, and on the directory it is
located in. You need read permissions on a file to open it. Another possibility
is that the file is corrupted or of a format Cenon is not capable to read. Check
for other messages in the Console.

* Could not open file FILENAME. Using Default.

Here Cenon tells you that it can’t read FILENAME, and uses default values
instead.
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* You have unsaved documents!
If you quit Cenon and have unsaved documents, this message appears to give
you a chance to save the files. You can review the unsaved files or quit anyway.

* Can’t write file.
Check the write permissions on the directory you try to save in. Also check if
there is already a file which you are not allowed to overwrite.

* FILENAME has changes. Save ?
This warning message appears if you try to close a window of a document
which hasn’t been saved yet. You have the choice to save the file or close it
anyway.

* Do you want to revert to: FILENAME ?
This is a safety message giving you a chance to cancel your request to reload a
file and loose all your changes.

* This Operation will force a recalculation of the graphic!

Cenon gives you a chance to cancel the operation or will start a recalculation.

* This Operation can take a while!

You are warned that the following operation will take some time and you have
to wait until has been finished. This message does not appear in expert mode.

* The contour will be calculated know! You may want to stop this operation
to calculate on a later time.

You are warned that the output tracks needs recalculation and you are given
a chance to calculate them on a later time. This message does not appear in
expert mode.

* Layer LAYERNAME needs recalculation!

If you start the output and the output tracks of some layers are not calculated
yet, Cenon gives you a chance to cancel and take a look at the tracks before
you start output. Otherwise the output is calculated and executed directly.
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No data to process!

You started the output without any data to process.

Couldn’t locate tool name TOOLNAME in magazine! You may have re-
moved the tool since your last session.

You have tools assigned to a layer of your job which is not in the active mag-
azine. Check the magazines for the needed tool or select a new tool from the
pop up menu.

Name 'NAME’ already in use!

If you add or rename a layer or position this message can appear. You should
rename the existing layer or choose a different name for the new one if possi-
ble.

You need to install the Cenon Library!

Some Library files are missing. On OpenStep the Library of Cenon has an
extra package. Most likely you haven’t installed it.

Only one layer of this kind allowed!

Cenon allows only one layer of the kinds: Fitting-Layer, Clipping-Layer, or
Levelling-Layer.

Only one position for parking allowed!

This shouldn’t happen at all, but somehow you tried to add a second layer for
the parking position. This is not possible.

Only a single rectangle allowed on leveling layer!

You created graphic objects on the leveling layer which are not allowed there.
Delete everything but a single rectangle.

This Operation will remove the fill layer attached to the Pick Out!

The Pick-Out owns a second layer. If you leave the correction for a Pick-Out
this layer is removed.
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* Automatic adjust! Be sure to have placed the surface sensor correctly,
before pressing ’Start’.

If your machine allows automatic measuring of the tool offset, this message
gives you a chance to place the switch under the tool before it starts the opera-
tion.

* Do you really want to remove the current magazine?
A warning message telling you that you are about to remove an entire maga-
zine.

* Set Magazine: This operation will remove all tools from layers!

A warning message telling you that you have to assign a new tool to all your
layers, if you select a new magazine. You have the chance to cancel your
request.

* Stop work?

A warning message. It appears when you click on Stop while the output is
running. The Z axis is lifted and you have a chance to check things, before you
continue or stop the output.

* Graphic out of range!

Your graphic is located outside of the machine table. Be sure that the graphic
you want to process is completely inside the gray lines, representing the ma-
chine table. You have a chance to continue, but this can lead to an incomplete
output of your graphic.

* Please log in as root!

Licensing only works as user root.

More messages can appear in the Console window (or system log file). Especially
messages during calculation of the output path are listed there.

On Linux this file can be found in the menu of the Window Manager under Info >
System Console. On OpenStep it can be found in Tools> Console of the Workspace
Manager.
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5.4 Keyboard Commands

Control-Panel:

Within the CAM control panel you have the following key commands available:

arrow up (8) moves the y-axis in positive direction
arrow down (2) moves the y-axis in negative direction
arrow right (6) moves the x-axis in positive direction
arrow left (4) moves the x-axis in negative direction
arrow up (9) lift the z-axis

arrow down (3) lower the z-axis

Ctrl (keep pressed) | move in 1.0 mm steps

Editing, Selecting
The keys Alt, Shift, and Ctrl can be used in combination with the mouse. The mean-

ing of these combinations can be found in the description of each mouse action. See
section ??.

Menu keys:

On Linux, the Command key usually is the Alt (Alternate) key.

‘ Command ‘ Key word ‘ Description
Cmd-a all Select all
Cmd-A Area Show Working Area panel
Cmd-b bold Change selected text to bold
Cmd-B Batch Batch Production
Cmd-c copy Copy selected objects into buffer
Cmd-C Color Show Color-Panel
Cmd-d direction | Revert direction
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Cmd-D Direction | Display directions of objects
Cmd-e equal Select equal objects

Cmd-F Form Show Transform-Panel
Cmd-g group Group selected objects
Cmd-G unGroup | Ungroup selected groups
Cmd-h hide Hide program

Cmd-i iltalic Change selected text to italic
Cmd-I Inspector | Show Inspector-Panel

Cmd-j join Join selected objects

Cmd-J unJoin Split joined objects (Path, Textpath, clipped Image)
Cmd-m mirror Mirror selected objects
Cmd-M Moves Show output tracks

Cmd-n new Create new document

Cmd-o open Open (Load) document
Cmd-O Optimize | Optimize moves

Cmd-p print Print document

Cmd-P Page Show Page-Layout panel
Cmd-q quit Quit program

Cmd-r rotate Rotate selected objects by 90°
Cmd-R Ruler Toggle text ruler

Cmd-s save Save document

Cmd-S Save as Save document with new name
Cmd-t text Show Font-Panel

Cmd-T Tool Display tool diameter

Cmd-u unsave Revert to saved document
Cmd-U pUnch Punch selected objects
Cmd-v view Paste buffer into document
Cmd-w window Close window

Cmd-x Cut selected objects into buffer
Cmd-z Undo

Cmd-Z Redo

Cmd-? ? Help
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Cmd-1 Graphic-Inspector, when editing text: Copy ruler
Cmd-2 Width-Inspector, when editing text: Paste ruler
Cmd-3 Fill-Inspector, when editing text: Copy font
Cmd-4 Texttype-Inspector, when editing text: Paste font
Cmd-5 Layer-Inspector

Cmd-8 Bring to front

Cmd-( Bring one object further to the front

Cmd-9 Send to back

Cmd-) Send one object further to the back

Cmd-# Toggle grid

Cmd-Shift-# Show Grid Panel

Cmd-< align text to the left

Cmd- center text

Cmd-> align text to the right

5.5 Frequently asked Questions

For an up-to-date version of the questions and answers visit the internet pages of
Cenon www.Cenon. info.

5.51 CAM

The tool radius is corrected more than expected

Newer versions of Cenon include the stroke width when correcting the tool radius.
You can set the stroke width of an object to 0 using the Inspector.

The tool radius isn’t corrected

You have to fill your graphic objects to allow a tool radius correction.
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Some characters have ugly sparcs in their output path

Your data contains lines or curves which are smaller than the tool radius. You should
remove these elements from your graphic. As an alternative you can switch to the
bitmap (raster) algorithm of Cenon (preferences option).

For my newly generated tool, the tool correction does the wrong thing or nothing
at all

Check the type of the tool (the pop up menu in the tool parameter panel). If you want
to cut you shouldn’t set the type of a drill for example!

5.5.2 CAM Production
The wrong configuration file is used

Probably your configuration file was found on a second place with the same name.
Device configuration files basically can reside in two places in the file system:

1. HOME/Library/Cenon/Devices/xyz (HOME is your home directory)

2. /Library/Application Support/Cenon/Devices/xyz
or for Linux:
/ust/GNUstep/Local/Library/Cenon/Devices/xyz
Configuration files in the first directory have priority and will be used if a file with

the same name resides in the second directory. This allows a user to modify a con-
figuration file without changing the installation of Cenon.

The spindle doesn’t start automatically or isn’t controlled by the application at
all

Check the preferences of Cenon, if the correct machine type with support of your
spindle is used.
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After updating Cenon, the machine doesn’t work any more

Check the preferences of Cenon to use the right type of machine.

The machine jerks sometimes and give bad results.

If you get an offset in your output (sometimes always at the same position), then
probably the positioning speed is too high and has to be lowered.

Not everything is send to the machine, even with all the eyes open in the CAM-
Panel

Go to the Control-Panel (CAM-Panel, Control) and set the radio button from "Selec-
tion" to "All".

The machine stops in the middle of the output (there appear messages in the
console window of the Workspace), or the machine moves to wrong positions

Probably you experience an EMV problem of the PC, and disturbances come in over
the serial interface. You should use a shielded serial cable (please use the cable
coming with your machine). Connect your PC with a separate wall-plug than for
example the vacuum cleaner. Also the use of a seperate serial card may help. Usually
a small company don’t have to buy an expensive industry PC to get rid of those
problems.

CNC 450: If I stop during output, the machine stops with delay

Cenon has to send some vectors in advance to the controller, so the machine can’t
stop before processing those vectors. To shorten the delay, you can modify the max-
imum size of lines in the layer details section of the CAM-Panel.
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Apple: the output is frozen and Cenon too

Plug out the serial adaptor from the USB interface for a short time. This will bring
back the controls. You are using a device configuration which uses a tty device
(entry #DEV) and you haven’t connected a device (or have connected a device which
doesn’t fit the configuration). To prevent future freezing, you can change the device
entry of your device configuration to use a cu device. To do this open the device
configuration in a text editor and change the device entry (#DEV) from tty to cu (see
section 4.2).

5.6 Serial Cable

To connect your machine or plotter to the computer you may still need a serial cable.
If possible you should use the cable you get with your machine.

1 13

6 25

oooooj&ooooooooooooo

The images show the pin numbering for male SUB-D connectors. You find them on
the PC side of the connection as well as on a serial adaptor (Apple). The female
connectors are numbered in reverse order.

This is the general pin layout of the serial connectors on PCs and most serial devices
(this is true for male and female connectors):
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‘ 9 pin ‘ 25 pin ‘ Pin Name | Pin Description

1 8 DCD Data Carrier Detect
2 3 RXD Receive Data

3 2 TXD Transmit Data

4 20 DTR Data Terminal Ready
5 7 GND Signal Ground

6 6 DSR Data Set Ready

7 4 RTS Ready To Send

8 5 CTS Clear To Send

The cable for connecting a plotter and some CNC controllers needs the following
connections to work with all handshakes. See the manual for your specific device for
further information.

‘ PC ‘ Plotter ‘
RXD | TXD
TXD | RXD
RTS | CTS
CTS | RTS
GND | GND
DCD | DTR
DTR | DCD
DCD | DSR

5.7 Glossary

"What does this mean?" is sometimes the question. This glossary should help you to
better understand technical terms and also give you a short explanation to important
terms from A (aperture table) to Z (Cenon). If more information is available in the
manual we will refer to the appropriate section of the manual.

Aperture Table A aperture table is necessary for importing Gerber files.
This file contains all the necessary D-code information
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Blow Up

CNC-Controller

Configuration file

Conical

Inlay

Excellon Format

173

to assign the aperture of the photo-plotter (soldering
point shape, sizes and conductor path thickness) to the
different layout elements of your CAD-program. The
aperture table used for export has to be used for im-
porting as well. The extended Gerber format doesn’t
need an aperture table any more.

Special kind of isolation tracks for producing PCB pro-
totypes. A blow up is used to increase the isolation
paths for easier soldering.

The CNC controller is the link between your computer
unit and the engraving unit. The controller converts
the signals send by Cenon to signals of higher electri-
cal current, so that they are able to power the different
axes of the engraving unit.

In your configuration file (extension .dev) control com-
mands and other parameter for the output device are
defined or different commands of the different import
formats are translated for Cenon.Default A default is
an entry preset by an application.

Conical describes a shape which goes from wide to
narrow.

Inlays are a special way of cutting material, so that one
part exactly fits into another.

Excellon is a data format used by industrial drilling
machines for drilling holes in circuit boards. Many of
the CAD programs can export these data and enable
you to import all the drilling information. The format
is imported using the DIN import.
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Extended Gerber

Gerber-Format

HPGL

Inner Contour

Insulation engraving

Outer Contour

Outline-Algorithm

Pick-Out

CHAPTER 5. APPENDIX

This is an improved Gerber format without the need
of a separated Aperture file. The format also allows
complex ground planes, which is very important for a
clean import of the data.

Gerber is a data format for exporting layout data. In
general, photo-plotter use this file format. Because
this file format is very common, most of the CAD-
programs are able to create files in this format.

This abbreviation is an acronym for "Hewlett Packard
Graphics Language" and is one of the well know and
mostly used command set for accessing pen plotter.

The inner contour is mainly used for calculating the
engraving path of filled areas. The appropriate tool is
labeled engraving tool.

Special kind of tool radius correction used to create
prototypes of printed circuit boards (PCBs). The insu-
lation is engraved around the tracks.

The calculation of the outer contour of components is
necessary, if the elements have to be cut-out totally
and the cut out should comply exactly with the layout
of the element. These cut-outs are normally done with
a milling tool.

The outline-algorithm is responsible for creating a con-
tour around graphic objects.

The pick out is a special method of creating output for
detailed engraving purposes. It is used with a conical
tool.
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PostScript PostScript is a vector based page description, which is
mainly used in the DTP area. This format is normally
used to drive photo-type-setters to create inexpensive
film layouts.

Project A project in Cenon is your document file. It is saved
with the extension ’.cenon’. In CAM applications a
Cenon project can also be called a job.

Rub-Out Rub-out area (especially PCB prototyping) indicates
areas were analog to the chemical process the conduc-
tion copper material is completely removed (important
for HF-applications). The actual tool diameter is used
for calculation of the appropriate path to completely
remove all the copper.

Sieb & Meyer Sieb & Meyer ist a industrial drill data format. The
two Sieb & Meyer formats (1000 and 3000) can be
imported using the DIN import.

Spindle Also called HF- or SF-spindle. Using high frequent
three-phase current, extremely high revolutions per minute
(RPM) can be generated, to achieve a precise output
and a high feeding speed.

Cenon Universal construction and production software.
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